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Citrix Session Remote Start

Introduction

October 10, 2025

For organizations using virtual apps and desktops, productivity starts after logging in. However, pro-
longed logon times, often lasting several minutes, disrupt workflows and disappoint the employees.
Citrix Session Remote Start addresses this challenge by delivering seamless, efficient, and faster ac-
cess to virtualized resources.

Session Remote Start provides APIs for trusted third-party services to enumerate, launch, and log off
Citrix sessions. It enables unattended logons triggered by events like building badge scans, eliminat-
ing delaysin time-intensive environments. Optional logon scripts can disconnect sessions post-logon,
keeping them ready for users to reconnect when needed.

With seamless integration into existing Citrix components, Session Remote Start simplifies deploy-
ment, enhances user experiences, and redefines how businesses manage virtualized access boosting
the overall productivity.

SRS Server System Requirements

The following table lists the minimum requirements for a Session Remote Start server.

Requirements Details

0sS Windows Server OS - recommended 2022 and
above

Processor 4 or more cores on a compatible 64-bit processor
with 2 GHz or faster

RAM Min 16GB

Storage 50

Session Remote Start - Prerequisites

The Session Remote Start requires the following components:

1. Windows Active Directory (AD) or Microsoft Entra hybrid-joined - Use an existing server or ser-
vice.

2. Citrix StoreFront 2311 or later - Use an existing server.

3. Citrix FAS (Federated Authentication Service) - Use an existing server, or set up a new one if
unavailable.
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4. StoreFront™ Store Configuration - Create a dedicated store on the Citrix StoreFront server ex-
clusively for Session Remote Start.

5. lISRequirement- [ISis required on the Session Remote Start server. Ifitis notinstalled already,
Session Remote Start installs it automatically (an internet connection is required).

6. SSL Certificates - install SSL certificates on both, the Session Remote Start server and the
servers making APl requests to ensure that only trusted services can issue requests.

7. Connectivity requirements - Session Remote Start must have a direct line-of-sight to Citrix
StoreFront and the VDAs intended for pre-launch.

Important Note:

+ Session Remote Start is compatible with Citrix Virtual Apps and Desktops™ and Citrix DaaS,
but only when StoreFront is used.

+ Currently, Session Remote Start does not support Citrix Workspace™ (the cloud version of
StoreFront).

« Citrix FAS and StoreFront are a mandatory requirements for Session Remote Start.

Architecture: Citrix Virtual Apps and Desktops and Citrix DaaS

You can deploy Session Remote Start on both Citrix Virtual Apps and Desktops and Citrix DaaS™ en-
vironments as long as you use Citrix StoreFront in DaaS instead of Citrix Workspace. Here are the
high-level architecture diagrams that explain the data flow, user action, and Session Remote Start
workflow.

Session Remote Start - Architecture for Citrix Virtual Apps and Desktops

External Triggers Data center
Prepare for Launch
. {Launch APl only}
Badging in DDe
1. APl Request (EnumerateiLaunch)
rTTTTTTTTUR == StoreFront < > FAS
: :
Biometric Scanner 1 ] 1
T ,. Session ]
- d 1. API Request " —
1 Rempw Start | 2 Enumerate/Prepare for Launch
! Service i
- ot :
s 1
b ]
1 N
3. Pre-launch {Launch API only)
1. APl Request
==
#4  Session Remote Start APIs only accessible to trusted machines Existing Gitrix Componant
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Session Remote Start - Architecture for Citrix DaaS

Citrix Cloud Azure
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Session Remote Start APls only accessible to trusted machines Existing Citrix Component

Installation of Session Remote Start

March 26, 2025

Installation Steps

Download the latest Session Remote Start installation package from Citrix Downloads.

.

The installation package has five folders, each containing the necessary files for deployment on
four different servers respectively.
Open the SessionRemoteStart folder, and double-click SessionRemoteStartSetup.

exe.
« Ensure to install as an administrator and follow the on-screen instructions to complete the in-
stallation.

Note:

If the installation fails, the completion page displays the location of the failure log. Open the log
file to review the installation failure details.
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Certificates

September 7, 2025

Install SSL Certificate for Accessing StoreFront™

During the use of Session Remote Start, a large number of calls to StoreFront’s APl are required. There-
fore, we need to install StoreFront’s certificate on the Session Remote Start server to ensure that Ses-
sion Remote Start can successfully access StoreFront’s Web APIs.

Note:

+ Session Remote Start is hosted on IIS and runs under a different identity than the user in-
stalling the certificate. Ensure that the Session Remote Start service has the necessary
permissions to load the certificate.

+ Citrix® recommends installing the certificate under Local Machine to allow access for all
users.

+ The 1IS identity under which Session Remote Start is running must be able to visit the
StoreFront URL of Receiver for Web Site without warning. (For example, https://
storefront.r1011.local/Citrix/srsWeb)

Import SSL certificate for Session Remote Start to IS Manager
Note:

Ignore this step if your Default Web Site is already configured.
Securing access and encrypting traffic with SSL certificates is the preferred way of deploying Session
Remote Start. Follow the steps below to achieve:

1. Open up IIS Manager, select the Session Remote Start Server name, and open the Server Cer-
tificates.
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fe > € » PMD-SERVER »

File  View Help

Q- I 12 18, @il PMD-SERVER Home

s Filter: + % Go - 5 Show All | Group by: -@-
-9 PMD-SERVER (rl01T\soaktest e o - (gyShow roup by: Area
i[5} Application Poels ASP.NET N
8] Sites 2 s ( ) r= | ELd
| 2 @ 5 5 N
MET NET .MET Error MET NET Trust  Application  Connection  Machineg|
Authorizat.. Compilation Pages Globalization Levels Settings Strings
s
L2 9 & &
Authentic.., Compression  Default Directory  Error Pages Handler HTTP ISAPI a
Document  Browsing Mappings Respon...  CGIRest)
- ;0 o= L
Cutput Request Server Worker
Caching Filtering Certificates | Processes
Management | Request and manage certificates for websites that use 551
SR
By
Configurat... Feature Shared

Editor Delegation Cenfigurat..

2. Click Import... in the Actions panel on the right.

Actions
Import Certificate 7 >
P I Import... I
r55 | Certificate file (pfx): Create Certificate Request...

Complete Certificate Reques

|C:\Users\suaktest-usﬂ'l'I\DDnrnIDadsisrs-semer.pfx |
] — Create Domain Certificate...

irati

5/2( Password: Create 5elf-Signed Certificat
5/2( | ‘ Enable -'i.u.t_c:n'u.a.ti-: Rebind of
29/3 Renewed Certificate

2/20) Select Certificate Store: @ Hep

Web Hosting ~

[ Allow this certificate to be exported

The settings shown for Select Certificate store and Allow this certificate to be exported in the im-
ages are recommended for enhanced security. If Web Hosting is selected, ensure to import the full
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certificate chain.

Also, ensure that the Session Remote Start service IS identity has the necessary permissions to load
the certificate.

Create HTTPS Binding

Note:

Ignore this step if your Default Web Site is already configured.

Create HTTPS binding in IS Manager.

Edit Site
~
T_:IZ D Ba
A w P d Vi
Type Host Name Port IP Address Binding Informa... id Caug:tsrz'?s
http 20 * -
- Ann e 1 Edit... Manage Website
sM Remove > Restart
Type: IP address: Port: Browse 8 con
https 10.0.0.7 v| |443 | | "
'E::\ Browse Website
Host name: g 2 Browse *:80 (http,
| |pmd75er\rer.r|011.|o(a| | Output B
Dt Caching
Require Server Name Indication Advanced Settings
Configure
[] Disable HTTP/2
[[] Disable OCSP Stapling _ z
~ 'Zg' Help

Close

551 certificate:

pmd-server b Select... View...

[y

. Open the IIS Manager, click Default Web Site under Sites.

N

. Ontheright panel, under Actions > Edit Site, click Bindings.
3. Click Add.

4. Under the Add Site Binding screen.

« Select the type as https.

« Set https port to 443.

 Enter the IP address and host name of Session Remote Start server respectively.
« Start server respectively in the respective fields.

« Click OK.

+ Click Edit on the newly created Binding.

+ Select the SSL certificate.
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Note:

For the Binding settings, it is considered that the third-party authentication service and Store-
Front use the same network connection for Session Remote Start. If they don’t, then remove
any IP address and hostname restrictions and clear the Require Server Name Indication check

box to avoid connection issues.

Require SSL

1. InlIS Manager, select the Session Remote Start Site, and double-click SSL Settings.

Connections
e Q Daps Home
93 NKGLLONGZW03 (CITRITE\lo _
"2 Application Pools Filter: + W Go -l Show All | Groupby: Area - E-
v Sites ASP.NET
v @ Daps 2 3 N = T 3 £ ] = : a
A 2 © @ = & é’;v e 3 B K = 2
NET NET  NETEror NET  NETProfile .NETRoles .NETTust .NETUsers Application Connection Machine Key Pagesand  Providers  Session State SMTP E-mail
Authorizat... Compilstion  Pages  Globalization Levels Settings Strings Controls
Iis
7 il = i o Y & = g o @ 8|
B 9 o = a &£ a4 = oAl B =
Authentic... Compression  Default Directory  ErrorPages  Handler HTTP ISAPIFilters  Logging ~ MIME Fypes  Modules Output Request | SSL Settings
Documen t  Browsing Mappings  Respon... Caching  Filtering
Management
Configurat. step1: click above
Editor

2. Onthe SSL Settings page, select Require SSL check box and under Client certificates, select
Accept and click Apply.

0 SSL Setti
ettings
v
@

This page lets you modify the S50 settings for the content of a website or application.

[ Require S5L

Client certificates:
O Ignare
® Accept

O Require

Configure Session Remote Start

December 9, 2025

Configuration file

The Session Remote Start configuration parameters are stored in the Web.config fi'le,whichis
located in the Session Remote Start installation directory C: \Program Files\Citrix\SRS\.
This file contains essential settings that control the behavior of Session Remote Start and should be
configured carefully to ensure proper functionality.
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Options

Parameter

StoreFront™

StoreFrontServer

LocalFqdn

SessionldCacheTtlSeconds

UselLegacyStoreFront

REST API

RestApiUrl

RestAPICredentialName

Siteld

Optional/Required

Required

Required

Optional

Optional

Optional

Optional

Optional

Description

The Store Web URL of the store
explicitly created for Session
Remote Start. E.g.
https://<baseURL>/
Citrix/<storename>Web

FQDN of Session Remote Start
server.
TTL of authentication session

between Session Remote Start
and StoreFront. The default
value is 300. Strongly
recommended to keep it
unchanged.

“True”if StoreFront is an earlier
version. The default value is
“false”.

Is needed only for certain
features, see [Configuration for
Accessing Other API
Beneedsdanlydorcertain
featuressSee/bpntigyration for
eéﬁ??gﬁﬁrﬂgt%@fzg% §ﬁngF@§dn-
Notsz4tthe Monjter sgrvice API
§@,cj,&g§§_APl use the same
NSEBNSBE DA APHRNS SR Mter
rgf%mr@g same credential

name.
[Is needed only for certain
features, See Configuration for
Accessing Other API Services.]
For CVAD on-Prem, fill with site
ID. For Daas, empty.

© 1997-2025 Citrix Systems, Inc. All rights reserved.
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Parameter

Customerld

DeliveryGroupsCacheTtIMinutes

DesktopsCacheTtIMinutes

ICA® Client

IcaClientName

Optional/Required

Optional

Optional

Optional

Required

Description

[Is needed only for certain
features, See Configuration for
Accessing Other API Services.]
For CVAD on-Prem,
‘CitrixOnPremises’. For DaaS,
customer ID.

TTL of

Delivery Group - Tag
mapping cache. The default
value is 10. Strongly
recommended to keep it
unchanged.

TTL of Desktop name cache.
The default value is 10.
Strongly recommended to keep
it unchanged.

A unique client name used for
Session Remote Start initiated
launches. Must be consistent
with the value of ‘SHostName’
in Logon Script
DisconnectSession.psl. Itis
recommended to keep the
default ‘srs-server’parameter.
Make sure the same value is set
in DisconnectSession.psl.

© 1997-2025 Citrix Systems, Inc. All rights reserved.
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Parameter Optional/Required
LaunchDebugMode Optional
IcaFileDirectory Optional
IcaLog Optional
IcaLogFile Optional

Session Remote Start

MaxRequestConcurrency Optional

RequestTimeoutSeconds Optional

Description

Enable launch debug mode.
The default value is ‘False’. If
setto ‘True’, the ICAfile is
saved to disk, and the launch is
not executed. Note: For
security reasons, the ICA file
does not contain sensitive
information. As a result, it can
only be used for connection
testing and cannot be used to
actually launch a session.

The directory of ICA files
(debug mode enabled). The
default value is “%App-
Data%\Citrix\SessionRemoteStart\IcaFiles”

“True”if you save the ICA
communication log. The
default value is “False”. It is
recommended to keep this
setting as ‘False’to save space.
Enabling it significantly
impacts performance and
should only be used for
troubleshooting.

ICA log path. The default value
is “%App-
Data%\Citrix\SessionRemoteStart\IcaLogs”

The number of concurrent API
requests. The default value is

100.
The timeout seconds of HTTP

request from a 3rd-party
service. The default value is
4‘300’7.

© 1997-2025 Citrix Systems, Inc. All rights reserved.
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Parameter

AutoRefreshConnections

Logging
LogToConsole
LogToConsoleLevel
LogToDebug
LogToDebugLevel

OverwriteLogFile

LogFileName

LogToFileLevel

MaxLogFileSizeMB

MaxBackupLogFiles

Optional/Required

Optional

Optional
Optional
Optional
Optional
Optional

Optional

Optional

Optional

Optional

Description

“True”if Session Remote Start
will auto refresh connections
periodically. Strongly
recommended to keep it
unchanged.

Developer use only.
Developer use only.
Developer use only.
Developer use only.

Overwrite the log file on the
next service start. The default
value is “false”.

Log file location. The default
value is “%App-
Data%\Citrix\SessionRemoteStart\Logs\Ses:
. If empty, no logging will
occur.

Trace severity level. See here
for details. The default value is
5.

Defines the maximum size of a
single log file (in MB). A new file
is created when this limit is
reached.

Specifies the maximum
number of backup log files to
keep. The oldest files are
deleted when the limit is
exceeded.

© 1997-2025 Citrix Systems, Inc. All rights reserved.
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Parameter Optional/Required

LogToEventViewer Optional

PreviousWebConfigDirectory Required

Telemetry

TelemetryCredentialName Optional
TelemetryDataDirectory Optional
TelemetryRotationDays Optional

Description

Enable event viewer logging.
The default valueis Fa'lse.
The log is under Windows Logs
> Application (path:
%SystemRoot%\System32
\Winevt\Logs\
Application.evtx)and
the event source name is
“SessionRemoteStart”.
Afolder that stores previous
configuration versions,
allowing SRS to monitor
changes to Web.config. The
default value is “%App-
Data%\Citrix\SessionRemoteStart\Previous/

[Is needed only for certain

features, See Configuration for

Accessing Other API Services.]

Configure Citrix Monitor

Service API Credential.

Note:

If the Monitor Service APl and
RAgdpfosyed telpppetry data.
LhedniastyaiHe Btions can
RAGRBE &M Ereliéntial

ﬁ%ﬁaj onRemoteStart)

TAERBEY DBAT o RLRBd Bty

YAHE BeBSS Tsekified, as it

The Aerberokdeysdedgsain
BrscdAtAgi eI 8096 Reer is
%a?@&itrix\SessionRemoteSta rt\Telemetn
and “%App-
Data%)\Citrix\SessionRemoteStart\Telemetry
directories.The default value is

90.

© 1997-2025 Citrix Systems, Inc. All rights reserved.
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Parameter

AutoTelemetryCollectingDays

Mutual TLS
mTLSEnabled

Optional/Required

Optional

Optional

mTLSClientCertificateThumbprintOptional

Smart Access Tags

SmartAccessFarmName

SmartAccessConditions

Auto Logoff
AutoLogoffEnabled

AutoLogoffldleMinutes

Optional

Optional

Optional

Optional

Description

The number of days of
telemetry data for SRS service
to collect automatically in the
background and store in the
telemetry data file.The default
value is 30.Note: The SRS
service needs about 30 minutes
for every 30 days to collect if
this feature is firstly used.

“True”if you want to enable
mTLS support. The default
value is “false”.

The thumbprint list of client
certificates, separated by
comma. Required if mTLS is
enabled.

Farm name, for example:
_XD_192.168.1.19_443
List of conditions, for example:
PL_WB_10.107.197.243,
PL_WB_10.107.197.244

[Is needed only for certain
features, see Configuration for
Accessing Other API Services.]
Enable automatic logoff for
sessions pre-launched by
Session Remote Start if never
reconnected within the
specified time. The default

value is “False”.
The idle duration (in minutes)

before automatically logging
off. The default value is 30.

© 1997-2025 Citrix Systems, Inc. All rights reserved.
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Parameter Optional/Required

AutoLogoffCheckintervalMinutes Optional

Support for Resuming
Hibernated VMs

ResumeMachinesEnabled Optional

ResumeMachinesCheckintervalMigtonal

BatchResumeMachinesDisabled Optional

BatchResumeMachinesintervalSedoptsnal

Description

The interval (in minutes) at
which Session Remote Start
server checks whether a
session needs to be auto
logged off. The default value is
5. Strongly recommended to
keep it unchanged.

[Is needed only for certain
features, See Configuration for
Accessing Other API Services.]
Enable resuming hibernated
machines during the
pre-launch process. The

default valueis False.
The interval (in minutes) at

which Session Remote Start
server synchronizes hibernated
machines. The minimum value

is 5. The default valueis 5.
Disable batch processing of
machine resume requests.
While requests may arrive
individually, they can be
processed in batches to
improve backend performance.
The default value is Fa'lse.
The interval (in seconds) at
which Session Remote Start
server resumes hibernated
machines in batches. The
default value is 10.

© 1997-2025 Citrix Systems, Inc. All rights reserved.
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Parameter Optional/Required Description

ResumingByStoreFront Optional By default, the SRS resumes a
hibernated VM through
Orchestration. To enable
resuming a hibernated VM
through StoreFront, the value
must be set to ‘true’. The
default value is “false”.

ReconnectionTimeoutSecondsAftediRé¢sumé Sets a timeout in seconds for
the temporary reconnection
afteraVM is resumed. Once
this time limit is reached, the
session is automatically
disconnected. This ensures the
session returnsto a
disconnected state. The default
value is 60.

For log-related configuration, see Change Log File/Telemetry File Location section.

Configuration file permissions

Check the permissions of the Web.conf-ig file located at C: \Program Files\Citrix\SRS\
Web.conf1ig (default location). Ensure that administrator accounts have full control over the file,
allowing them to read, modify, and manage it. At the same time, other users or groups should not
have modify permissions to prevent unauthorized changes.

This helps maintain security and prevents unintended modifications to the configuration.

© 1997-2025 Citrix Systems, Inc. All rights reserved. 16
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o Web.config Properties >

General Securty Details  Previous Versions
Object name:  C:\Program Files'\Citrix5rs Web config

Group or user Names:

ALL APPLICATION PACKAGES

[E)ALL RESTRICTED APFLICATION PACKAGES
H2SYSTEM

A Administrators (pmd-server' Administrators)
52 Users {pmd-server'lsers)

To change permissions, click Edit. Edit .

Pemissions for Administrataors Allow Dery

Full contral

Modify

Read & execute
Read

Write

Special pemissions

For special pemmissions or advanced settings. Advanced
click Advanced. =

Corcal | | oo

StoreFront™ Configuration

November 26, 2025

Install SSL certificate for accessing Session Remote Start

To simplify deployment, each Session Remote Start server is set up as a specialized Gateway
with StoreFront. Therefore, StoreFront must be able to communicate with Session Remote Start
using the specified Gateway callback URL: https://<Session Remote Start FQDN>/
SessionRemoteStart/CitrixAuthService/AuthService.asmx.

© 1997-2025 Citrix Systems, Inc. All rights reserved. 17
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Add Session Remote Start as a Gateway

1. Click Manage Citrix Gateways in the Stores panel on the right.

Actions
Stores -
| Subscription Enabled Access Create Store
Yes Internal network only Export Multi-Store Provisioning File
| Manage Citrix Gateways |
Manage Citrix Gateways Manage Beacons
Set Default Website
Add, edit or remove the Citrix Gateway appliances through which remote access is provided. Remote
access through a Citrix Gateway cannot be applied to unauthenticated stores, View '
Alternatively, Citrix Gateway appliances can be importad from file. G4 Refresh
[ Hep
Citrix Gateways:
daps -
Display Name Role | Used by St | URL -
Manage Delivery Controllers
Configure Unified Experience
Manage Authentication Methods
Manage Receiver for Web Sites
Configure Remote Access Settings
Configure XenApp Services Support
Ed Configure Store Settings
Export Provisioning File
Remove Store
B rer
2. Add a new gateway.
Actions
Stores -
Crete stoe
Yes Internal network anly Export Multi-5tore Provisioning File
Manage Citrix Gateways
Manage Citrix Gateways Manage Beacons
Set Default Website
Add, edit or remove the Citrix Gateway appliances through which remote access is provided. Remote X
access through a Citrix Gateway cannot be applied to unauthenticated stores, View »
Alternatively, Citrix Gateway appliances can be imported from file. |Gy Refresh
[ Help
Citrix Gateways:
daps -

Display Name

Role | Used by St | URL

Manage Delivery Controllers
Configure Unified Experience
Manage Authentication Methods
Manage Receiver for Web Sites
Configure Remote Access Settings
Configure XenApp Services Support
Configure Store Settings

Export Provisioning File

Remove Store

ﬂ Help

3. Set Display name, set Citrix Gateway URL with https://<Session Remote Start

FODN>/SessionRemoteStart/,and change Usage or role to Authentication only.

© 1997-2025 Citrix Systems, Inc. All rights reserved.
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Add Citrix Gateway Appliance

StoreFront General Settings

Complete these settings to configure access to stores through Citrix Gateway for users connecting
from public networks, Remote access through a Citrix Gateway cannot be applied to

General Settings unauthenticated stores.

Authentication Settings .
Display name: | srs |

Summary

Citrix Gateway URL: |d—ser\.fer.r|0‘|‘|.IocaUSessionRemGteStarbd |

Usage or role: @ [Authentication only A ]

4, SetCallbackURLwithhttps://<Session Remote Start FQDN>/SessionRemoteStart

© 1997-2025 Citrix Systems, Inc. All rights reserved. 19
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Add Citrix Gateway Appliance

StoreFront Authentication Settings

These settings specify how the remote user provides authentication credentials

General Settings

zeneral o gs Version: 10.0 (Build 69.4) or later -
Authentication Settings VServer IP address: S 10.0: SNIP or MU 1012 B
Summary (optional) ’
Logon type: @ Domain w7
[Coaplt?;i II]U RL: @ | https://pmd-server.rlll1.local/Sess: (| /CitrixAuthService/AuthService.asmx

Back m Cancel

Create a New Store for Session Remote Start

A new Store must be created exclusively for Session Remote Start to ensure proper functionality and
integration.

Manage Authentication Methods
1. On the new Store, find the Manage Authentication Methods in the Store configuration panel
on theright.
2. Ensure the Pass-through from Citrix Gateway check box is selected.

3. Expand settings, click Configure Delegated Authentication.
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Manage Authentication Methods - daps

Select the methods which users will use to authenticate and access resources.

|G| Refresh
ﬂ Help

0 | |

Method

User name and password

[]  SAML Authentication

[[] Domain pass-through

Can be enabled / disabled separately on Receiver for Web sites

[]  Smartcard
Can be enabled / disabled separately on Receiver for Web sites

[] HTTP Basic

v Pass-through from Citrix Gateway €9

Manage Delivery Controllers

Settings
- Configure Unified Experience
Manage Authentication Meth

b

Manage Receiver for Web Sitel
Configure Remote Access Setd
Configure XenApp Services 5u
Configure Store Settings
Export Provisioning File

=

Remove Store

Installing and uninstalling the authentication methods and the
authentication service settings are included in the advanced options.

Configure Trusted Domains
Ad | Configure Delegated Authentication

Manage Password Options

Configure Password Validation

oI

4. Enable the Fully delegate credential validation to Citrix Gateway option.

Manage Authentication Methods - d

I Select the methods which users will use to authenticate and access resources.

i)

Methad

[ | llcar narma and naccuned

Configure Delegated Authentication

applied when users log on with smart cards.

Fully delegate credential validation to Citrix Gateway

Specify whether StoreFront fully delegates credential validation to Citrix Gateway. This setting is

Settings
T

-

Tn=tal ng and unlnstalllng The auihenticaton methods and the
authentication service settings are included in the advanced options.

Advanced ¥

-

Configure Remote Access Settings

1. Click Configure Remote Access Settings in the Store configuration panel on the right.

2. Check the box Enable Remote Access.

3. Select the Gateway configured above.
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Helj

Configure Remote Access Settings - daps | 2 i

daps

Enabling remate access allows users cutside the firewall to securely access resources. After Manage Delivery Contrallers

you enabile remote access, add a Citrx Gateway. Configure Unified Experience

Manage Authentication Methods
# Enable Remaote Access

- Manage Receiver for Web Sites
Select the permitted level of sceess to internal ressurces

| Configure Remote Access Settings I

®! Allow users to access only resources delivered through StoreFront (Mo VPN tunnel) € Conf Yenhop Se P "
onfigure XenApp Services Suppo

Allow users to access all resources on the internal network (Full VPN tunnel) @ Configure Stare Settings
PN tunnel Export Provisioning File

Remove Store

daps L H Hep

Jackw-daps-test

Citrix Gateway appliances:

jackw-n]
[PEE .

Add...

Default appliance: srs .

Configure DDC

September 13,2025

Enable TrustRequestsSentToTheXmlServicePort

Enable this setting on the Delivery Controller™ (DDC) to ensure that Session Remote Start requests
coming through StoreFront are trusted.

For Citrix Virtual Apps and Desktops™

Run the following commandlets on the Delivery Controller:

asnp Citrix*
Set-BrokerSite -TrustRequestsSentToTheXmlServicePort $true

For Citrix DaaS™

Run the following commandlets:

1. On a machine with internet connection, install Citrix DaaS Remote PowerShell SDK.
Other articles also contain related information:

2. Open PowerShell, and execute the command:
Get-XdAuthentication
An authentication dialog opens.
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3. Execute the commandlets as On-Prem:
asnp Citrixx

Set-BrokerSite -TrustRequestsSentToTheXmlServicePort S$true

4. Log off.
Clear-XDCredentials

App Protection: If customers have an App protected delivery group, see App Protection.

HTTP Proxy: Customers must configure the necessary settings and follow the steps in HTTP Proxy
Configuration if their setup includes HTTP proxies to ensure proper functionality.

AD Server - Logon Script Configuration

March 12,2025

The Logon script is used by the Virtual Delivery Agent (VDA) to disconnect the pre-launch session after
the Session Remote Start initiated logon completes. This scriptis applied to all VDAs and users using
Group Policy to ensure that no resources remain active and unused. It allows users to reconnect later
through their regular login method, ensuring efficient resource management and a seamless user ex-
perience.

Steps to create a GPO and link it to a Domain

1. On the Windows domain controller, open Group Policy Management and create a GPO under
the domain or on the Citrix VDAs OU.

|5k Group Policy Management - m} X
|3 File Action View Window Help - &
e=|zmlEo|lXE HE
=k Group Policy Management citrixPolicy
v —ﬁ Forest: EVT'LOCAL Scope  Details Settings Delegation  Status

~ |53 Domains
Vs Links
v [ BT P . o
I Create a GPQ in this domain, and Link it here... s location: BYT.LOCAL ~
m L it (EFE o 8 i, domains, and OUs are linked to this GPO:
Falll Block Inheritance
B i Enforced Link Enabled Path
:Z t Group Policy Medeling Wizard... Mo Yes BYT.LOCAL
v [5G New Organizational Unit
T Search...
i Change Domain Controller...
,. \ Remove
& < Active Directory Users and Computers... >
@ Sites
L'. Group P New Window from Here -
¢ Group P Refresh 3 GPO can only apply to the following groups, users. and computers
Properties
d Users
Help
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2. Right-click on the GPO, select Edit to open the Group Policy Management Editor.

L Group Policy Management
v /4 Forest: BVT.LOCAL
~ [ Domains
v 3 BVT.LOCAL
sz CitrixPolicy
s/ Default Domain Policy
s LogonScript

2| Domain Cc Edit... zation
o test0l Enforced BVT.LOCAL
3] test2 «  Link Enabled
~ [ 5t Group Poli
Save Report...
1= CitrixPe ———
= Default View 5
L/ Default Mew Window from Here
5[ Logens
S WM Eilrare Delete

LogonScript
Scope Details  Settings
Links
Display links in this location|

The following sites, domain

3. In the Group Policy Management Editor, expand User Configuration > Policies > Windows
Settings > Scripts (Logon/Logoff). Right-click Logon on in the right panel and select Proper-

ties.
=/ Group Policy Management Editor — O
File Action View Help
L Al ENES 7]
5[ LogonScript [DCO1.BVT.LOCAL] Policy = Scripts (Logon/Logoff)
v i Computer Configuration = N
| Policies Logon ame
| Preferences Display Properties
v i, User Configuration pay - [£] Logoff Properties
hd ;EDHCiES Description: ) Help
| Software Settings Contains user logon scripts.

~ | Windows Settings
= Scripts (Legon/Logoff)
T Security Settings
[Z] Folder Redirection
oliy Policy-based QoS
| Administrative Templates: Policy definitic
| Preferences

W

<

Opens the properties dialog box for the current selection.

\ Extended /(\Standard/

4. Switch to the PowerShell Scripts tab, and click Add....
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Scripts  PowerShell Scripts
'ﬁf Windows PowerShell Logon Scripts for LogonScript
Name Parameters Up
Down
Add..
Edit...
Add a Script %
Seript Name:
|| | Browse...
Script Parameters:
OK Cancel
T
> |\ Extended /(Standard/

5. Click Browse... on the right of the Script Name field, a file browser pops up, located in the
NetLogon folder by default.
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Logen Properties ? X

Serpts PowerShell Scripts

Windows PowerShell Logon Scripts for LoganScript

Mame Parameters Up

Down

Add a Script X

Scrpt Name:

Script Parameters:

Browse

1T+ « BVT.LOCAL » SysWol » BVT.LOCAL » Policies » {79D068D1-4281-4509-BCB6-17A71BOF290F} » User » Scripts » Logon ~ [4] Search Logon R

Organize » Mew folder B M @

Name Date modified Type Size
# Quick access

1 Desktop
4 Downloads
Documents
[&] Pictures
DisConnect

No items match your search.

EOSEE

en-US
Logon

scripts

[ This PC

8 30 Objects
I Desktop
Documents
4 Downloads
D Music

[&] Pictures

B Videos

e Windows (C:)

= Temporary Storage

= Network

The Logon folder is a shared folder which typically has read-only and execute permissions by
machines and users. To avoid permission issues, it is recommended not to use any other folder.

Create DisconnectSession.psl under this folder.

Note:

Use the one provided by Citrix as part of the installation file.
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Browse

T <« BVT.LOCAL » SysVol » BVT.LOCAL » Policies » {79D068D1-4281-4509-BC86-17A71BOF290F} > User > Scripts > Logon
Organize *  New folder

Name Date modified Type Size
# Quick access

I Desktop & DisconnectSession 3/26/2024 2:47 AM Windows Powers... 1KB
< Downloads
[Z| Documents
&= Pictures
DisConnect
en-US
Logen
scripts
& This PC
) 3D Objects
[ Desktop
% Documents
< Downloads
D Music
=] Pictures
B videos
‘i Windows (C2)

= Temporary Storage

¥ Network

@ | Searchlogon »

= O @

File name: | DisconnectSession

| [AlFites v

6. Select Run Windows PowerShell scripts last and click OK or Apply.

Logon Properties ? X

Scripts  PowerShell Scripts

E{ Windows PowerShell Logon Scripts for LogonScript

Name Parameters Up

Disconnect Session ps1 Down

Edit...

Remove

Forthis GPO, run scripts in the following order:

Not corfigured e

Mot configured
Run Windows PowerShell scripts first
PowerShell scripts last

ndows Server

Show Files...

Cancel Aoply

Configure Citrix FAS

September 7, 2025
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Steps to Install and configure FAS

To install and configure FAS in your setup, see Install and configure.

FAS Do’s and Dont’s

1. Itis mandatory to Enable the FAS plug-in for the SRS Store only (using the PowerShell script) as
we are using Citrix Virtual Apps and Desktops StoreFront.

2. Check the rule on your FAS server, to ensure your STF is allowed in the Manage StoreFront™
Permissions page.

a) Be aware that by default, there is a DENY entry for Domain Computers. On windows DENY
always “wins”.

b) Verify if the permissions from Storefront servers for groups such as domain computers is
not set to Deny.

c) Verify if FAS rules > access control > domain computers is set to Allow.

3. Ensure the domain users are added in the FAS console.

a) FAS console > Rule Default > restrictions > Manage user permissions check if you have

the domain user here.
b) Set the Domain users for FAS user authentication in the FAS console to allowed.

4. Storefront servers should be authorized to use FAS by default, if not, do it explicitly.

a) Onthe FAS server, open Citrix Federated Authentication Service console.
b) Go to the Rules tab, select the appropriate policy and click the pencil icon to edit.
c) On the left menu select Access control and click the Manage StoreFront access permis-

sions link.
d) In the Permission for StoreFront Servers page, add your StoreFront servers and give
them the Assert Identity permission and click OK.

Installation checklist

September 13,2025

Session Remote Start Server

1. Open<https: in a browser and verify that it

loads without any warnings.
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Note:

Ignore the No logon methods are available on this platform message.

2. If LogFileName is configured:

+ Check if the log file exists.
+ Review the log for any errors that may indicate issues with the setup.

3rd-party Auth Service Server

1. Openhttps://<Session Remote Start FQDN>/SessionRemoteStart/index.
html and verify if it opens without a warning.

StoreFront™ Server

1. Open <https://<Session Remote Start FQDN>/SessionRemoteStart/
CitrixAuthService/AuthService.asmx> and verify if it opens without a warning.
2. Double check the configurations, including:

a) Gateway, especially double check the gateway URL and callback URL must be
Session Remote Start server( https://<Session Remote Start FQDN>/
SessionRemoteStart).

b) Authentication methods, especially Delegated Authentication.

c) Remote Access, specifically applies to the gateway configured above.

3. Federated Authentication Service integration should be enabled on a StoreFront Store using the
PowerShell script. For more information, see, Enable the FAS plug-in on StoreFront stores.

DDC
Check if TrustRequestsSentToTheXmlServicePort is enabled. Run the following commandlets:

asnp Citrixx
Get-BrokerSite

For more information about the commandlets, see DDC Configuration.

AD

Verify if the logon script is configured.
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FAS

If FAS has never been installed before, and it is specifically for the installation of Session Remote Start,
please ensure that FAS is correctly configured and functional.

1. Reconfirm that FAS plug-in is enabled on StoreFront for SRS store, as mentioned in StoreFront
checklist using the PowerShell script.

2. Reconfirm that DDC trust the StoreFront servers requests, as mentioned in DDC checklist
(TrustRequestsSentToTheXmlServicePort enabled).

3. Confirm that Group Policy is correctly configured, especially FAS FQDN is configured. Confirm
Group Policy is applied to all necessary machines (StoreFront/VDA/DDC).

4. Confirm the user rules. If the default rule is used for quick FAS configuration, please do confirm
that Domain Computers is NOT denied.

*

&4 Citrix FAS Administration Console - connected to localhost - O

Initial Setup Rules  Advanced Connect to another server  Refresh

Complete these setup steps:
o Deploy certificate templates Deploy

The required templates are deployed in Active Directory.

o Set up a certificate authority

The authorization templates are published on: jackw-ad xiaow. local\xiaow-jackw-ad-CA.

Click "Publish” to publish the templates on another certificate authority.

o Authorize this service Reauthorize

An authorization certificate is configured.

Deauthorize this service.

o Create arule Create

You have a rule configur

Connect to Citrix Cloud Connect

Complete this step if you wish to use this FAS service with Citrix Cloud.
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¢ Citrix FAS Administration Console - connected to localhost — O *
Initial Setup |Rules | Advanced Connect to another server  Refresh
Complg % Edit Rule — O >
o Edit rule "Default” .
Template

Specify which StoreFront servers can use this rule. You can select individual machine
accounts or Active Directory security groups.

——-...\ Permissions for StoreFront Servers *
anage StoreFront access permissions ¥

Security

R — Note: if you are only planning to use this rulg| Gup oruser names:
0 grant access to any StoreFront servers. in

Restrictions

0 Certificate authority

In-session use

Summary

o Add.. Remove

Pemissions for Domain
Computers low Deny

Assert |dentity O

G| [

User Logon Name

For every end user, the User logon name must be configured.

© 1997-2025 Citrix Systems, Inc. All rights reserved. 31




Citrix Session Remote Start

File Action View Help
e HE B XEd=BEI eSS TE%
| Active Directory Users and Com|| Name Type Description
: Saved Queries % pmd-user1 User
v r\.DH‘\ocaI &, pmd-usert9 User
| Builtin
“| Computers & pmd-user2 User pmd-userdd Properties 7 X
21 Domain Controllers &pmd-userlo User
| ForeignSecurityPrincipal; & pmd-user21 User Member Of Dial4n Environment Sessions
“| Managed Service Accout & pmd-user22 User Remote control Remate Desktop Services Profile COM+
4 Users & pmd-user23 User Generdl  Addess  Account | Profie  Telephones  Organization
a %pmd—userlti User
User logon name
&pmd-userls User
&pmd-userlﬁ User i
2, pmd-user2? User User logon name (pre-Windows 2000)
&, pmd-user2s User [ro1ns | [pmd-userss
2, pmd-user2s User
% prod-user3 User Logon Hours... Log On To..
%pmd—user}ﬂ User
& pmd-user31 User [ Unlock account
&pmd-userBZ User
&, pmd-user33 User Account options
& pmd-user3d User [J User must change password at next logon i
S pmd-user33 User [J User cannot change password
&, prod-user3s User Password never expires
& pmd-userd7 User [ Store password using reversible encryption v
&pmd-userBS User .
Accourt expires
&pmd-userBQ User
E;pmd-userrl User ® Hever
S pmd-userdD User (O End of: Thursday . December 12, 2024
%pmd—usem‘\ User
%pmd—useml User
&pmd-usenﬁ User
&, prmd-userd4 User Cancel Apply Help
&pmd-usemﬁ User
&, pmd-userds User
2, pmd-userd7 User
%pmd—usems User
%pmd-usenig User
&pmd-useri User
< > || . nmd-usersn User

Session Remote Start local testing

March 12,2025
Note:

Some features may require additional configurations. For more information, see Optional Con-
figuration.

Open Session Remote Start Web Local Testing

Openhttps://<Session Remote Start FQDN>/SessionRemoteStart/index.html,
in a web browser and check if it loads successfully without any warnings.

There are three tabs on the top left: Enumerate and Launch, Launch Desktops, and Logoff.

1. Enumerate and Launch: Enumerate available resources for a User Principal Name (UPN) and
allows launching a selected resource for the UPN.
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2. Launch Desktops: Session Remote Start supports launching all desktops using three methods.

+ Launch All Desktops of a User Principal Name (UPN)
+ Launch All Desktops by Tags of a User Principal Name (UPN)
+ Launch All Desktops assigned to the UPNs in the specified AD groups

3. Logoff: Logs off all sessions for a given UPN and device name.

=5 dapshostbut localse

Leaming Cont. (@ Citrin Workspace by Tickets - Citrite. % | G 3 Citrinlser Doc | Citrin Adewin Doc @) Citr sy 5 Coverit Wy Apps Dashboar

Enumedate and Launch | Launch Deskiops | Logofl

Enumerate and Launch Resource of a User Principal Name (UPN)

Ermumerates resouwces for a given UPH. On success, a list of one or mone nesources s
returned. [f thene were na resources fownd for the user o the AP| failed to feich the hist of
TESCATCES, 3N &mol is retumed

Launches the specified resource for the given UPN. The API will return ance logon has
compileted, or if an emor has occurred. Mote that as logon may lake several minules o
complete (for example, if the maching i powering up), this AP1 will block the calling
Eheead for the same amount of time

Enumerate and Launch Resource

UPH:

Enumarate Resources

Enumerate and Launch Resource of a User Principal Name (UPN)

Input the User Principal Name (UPN), then click Enumerate Resources.
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al,

% Citrix Developer Doc 5 Citsix User Doc % Citrix Admin Doc  @W Citsix Backstage 5 Cowerity My A

Enumerate and Launch Resource of a User Principal Name (UPN)

Enumerates resources for a given UPN. On success, a ist of one or more resources is
retumed. If there were no resources found for the user or the API failed 1o fetch the list of
FESOUICES, AN o is returned.

Launches the specified resource for the given UPN. The AP will return once logon has
completed, or if an emor has occumed. Note that as logon may take several minutes to
comphete (for example, if the maching i5 powenng up), ths AP will block the calling
thread for the same amount of time.

Enumerate and Launch Resource

UPN:

hongi@b local

Enumerate Resoun

MName: Daily ms 1

ResourceMame: hong Daily ms 1 $513-16

ResourceType: Desktop

ResourcelURL: Resources/LaunchicalaGauZySEYWiseSBicyAXICRTMTMIMTY- ica

Launch Daily ms 1

Name: Google Chrome

ResourceMame: hong Google Chrome

ResourceType: Apphcation

ResourcelJRL: Resources/Launchica/aGouZySHb29nbGUgl2hyb21lica

Launch Google Chrome

MName: Occasional ss 1

ResourceMame: hong Occasional 55 1 $A10-4-2F5CBDSF-0001

ResourceType: Desktop

ResourcelRL: Resources/Launchlca/aGouZy5PY 2Nhc2ivbmF sIHNzI DEgJEEXMCO0LTJGNUNCRDVGLTAWMDE- ica

Launch Qccasional 55 1

Name: Visual Studie 2022

ResourceMame: hong Visual Studo 2022

ResourceType: Application

ResourcelJRL: Resources/Launchica/aGouZy5WakXN 1Y WwgLU3R1ZGIDIwMjl-ica

Launch Visual Studio 2022

Name: ig#i4

ResourceMame: hong 2T

ResourceType: Apphication

ResourcelURL: Resources/LaunchlcalaGOuZyTorrDkuowmnkw- ica

A

Then choose aresource, forexample: Daily ms landclickLaunch Daily ms 1. TheAPlwaits
for a logon notification from the VDA before returning to the caller.
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@ Citrix Backitage

Enumerate and Launch Resource of a User Principal Name (UPN)

Enumerates resources for a given LUPH. On success, a list of one or more resources is
returned. If thene were no resources found for the user or the AP failed 1o fetch the kst of
TESOURCES, AN efTor is retumed

Launches the specified resource for the given UPN. The AP1 will return once logon has
completed, or f an error has occurred. Note thal as logon may take several manules 1o
complete {for example, if the machine is powering up), this AP1 will block the caling
thread for the same amount of time

Enumerate and Launch Resource

UPN:

hongitvt ocal

Mame: Daily ms 1

ResourceName: hong Daily ms 1 $513-16

ResourceType: Desklop

ResourceURL: Resources/LaunchicalaGoudy3EY WiseSBicyAxICRTMTMIMTY- ica

Name: Geogle Chrome

ResourceMame: hong Gaogle Chrome

ResourceType: Application

ResourcelURL: Resources/LaunchicalaGouZySHb20nsGUgQ2hyb2 11 ica

Name: Occasional 55 1

ResourceMame: hong Occasional 55 1 5A10-4-2F5CBDSF-0001

Resource Type: Desklop

ResourcellRL: Resources/LaunchicalaGauZySFyY 2Nhe 2ivbmF sIHNzZI DEgJEExMCOOLTJGNUNCRDVGLTAWMDE- ica

MName: Visual Studio 2022

ResourceName: hong Visual Studm 2022

ResourceType: Application

ResourcelURL: Resources/Launchica/aGouZySWakN1YWwgUIR 1ZGhID wMl- ica

Name: iCHiA

ResourceName: hong iCBEE

ResourceType Apphcabon

ResourcelRL: Resources/Launchica/aGouZyTorDkuovmnkw- ica

A prompt appears with a notification if the resource is launched successfully. Then, check the session
in the studio.

© 1997-2025 Citrix Systems, Inc. All rights reserved. 35



Citrix Session Remote Start

C [ 23 dapshostbvtlocal,

Leaming Cent.. (@ Citrix Workspace My Tickets - Citrite... fstage  § Coverity My Apps Dashb

dapshost.bvt.local says

Enumerate and Launch | Launch Deskiops | Logoff Launch completed. Transaction|D: b004cfa0-aff2-4e6f-290e-
da76fb433fb1, Status: Success.
Enumerat Please check the session in studio. ime (UPN)
Enumerate DUICES IS
returned. Il h the list of

resources, an error is returned

Launches the specified resource for the given UPN. The APl will return once logon has
completed, or if an error has occurred. Note that as logon may take several minutes to
complete (for example, if the machine is powering up), this APl will block the calling
thread for the same amount of time

Enumerate and Launch Resource

c

PN:

hong@bvt local

Enumerate Resources

Name: Daily ms 1

ResourceName: hong.Daily ms 1 $513-16

ResourceType: Deskiop

ResourceURL: Resources/Launchlca/aGluZy5EYWIseSBicyAxICRTMTMIMTY- ica

Launch Daily ms 1

Name: Google Chrome

ResourceName: hong Google Chrome

ResourceType: Application

ResourcelURL: Resources/Launchlca/aG9uZy5Hb29nbGUgQ2Zhyb21l.ica

Launch Google Chrome

Name: Occasional ss 1

ResourceName: hong.Occasional ss 1 $A10-4-2F5CBD5F-0001

ResourceType: Deskiop

ResourceURL: Resources/Launchlca/aGuZy5PY2Nhc2lvbmFsIHNzIDEgJEEXMCOO0LTJGNUNCRDVGLTAWMDE- ica

Launch Occasional ss 1

Name: Visual Studio 2022

ResourceName: hong Visual Studio 2022

ResourceType: Application

ResourceURL: Resources/Launchlca/aGSuZySWaXN1YWwgU3R1ZGIvIDIwMjl-.ica

Launch Visual Studio 2022

Name id$E4

ResourceName: hong eSS4

ResourceType: Application

ResourceURL: Resources/Launchlca/aG9uZy7orDkuovmnKw-.ica

Launch 8584
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Single-session 05 Machines | 2 Multi-session 05 Machines [ 1 Sessions o

(3 LogOff <@ View Machines oo s Maore M 1D
CurrentU.. & | Mame | Delivery Group Machine Catalog | Brokering Time .. | Session State | Application State | Session Supp...
BVT\hong dapsTSVDA BVTLOCAL Daily Group Daily Catalog - Disconnected Desktop Muslti

BVT\hong - dapsTSVDA.BVT.LOCAL

Session  Administrators

Session Machine
BVTwhang Machine dapsTSVDABVTLOCAL
Hux Delivery Groug Deaily Grgup

Sexzion Ty Dasktop & Catalog Daily Catalog

S Disconnected

T T minutes

12130124, 545 AM
12030024, 145 PM (Lecal, UTC+08:00)
ation State Dasktop
Jars-server]
0000
Uinkngwn
vlD
dapsDDC BVTLOCAL
dapshast bvt Incal
T 10147.232.66
05 Type Windows 2022

Launch Desktops
Launch All Desktops of a User Principal Name (UPN)

Enter the User Principal Name (UPN) and click Launch All Desktops. A prompt will confirm whether
the resources launched successfully. Then, verify the sessions in Citrix Studio.

E m 23 dapshostbvtlocal/sessionremotestart

«  Citrix Learning Cent... @ Citrix Workspace My Tickets - Citrite...
dapshost.bvt.local says
Enumerate and Launch | Launch Deskiops | Logoff Launch all desktops completed. TransactioniD:
36bed72c-6784-4113-9%a-c55fba02dbod, Status: Success.
Laur rlease check sessions in studio. ’N]

Launches al it waiting

for logon co,

Launch All Desktops
Upn:

hong@bvt local
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n 05 Machine: 2

Session Administrators

Session
BEVTihong
Hidx
Deskiop
Disconnected
Stats 0 minutes
123024, 614 AM

Deckiop
s7s-server
0000
Unkncwn
w0
dapsDDC EVTLOCAL
dapshost byt local
1014723286
S Ty Windows 10

* Log Off @ View Machines === More
Current U... 4 | Mame
BVTihong dapsTSVDA BVTLOCAL
BVTihong launchAllTestSSBVTLOCAL
BVTihong dapsV DA BVTLOCAL

BVTihong - launchAllTestSS.BVT.LOCAL

| Delivery Group

Daily Group
Occasional Group 1

Occasional Group 1

12730v24. 214 PM (Local. UTC+08:00)

Sessions B‘

Machina Catalog
Daily Catalog
Occasional Catalog 2

Occasional Catalog 1

| Brokering ...

Machine

Session State | Application State
Dizconnected Deskiop
Disconnected Desktop
Disconnected Desktep

launchAllTestSS BVTLOCAL
Dogas o :

onal Groyp 1

Dcoasionsl Catalog 2

t

Session 5.,

Multi
Single

Single

m

Launch All Desktops by Tags of a User Principal Name (UPN)

Enter the User Principal Name (UPN) and tags, scroll down and then click Launch All Desktops By
Tags. A prompt will confirm whether the resource is successfully triggered. Then, verify the sessions

in Citrix Studio.
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% dap bt local

itrin Learning Cent.. (@) Citrix Workspace ctage 5 Cowerity My Apps Dachbaar...

dapshost.bvtlocal says

Enurnerate and Launch | Launch Desktops | Logaff Launch 3l desktops by 1ags completed. TransactioniC:
024ee250-9185-417¢-be 12-2 14181112142, Status: Suceess.
Laur  Please check sessions in studis. 'N)
Launches al @ ut waiting
for logon co,

Launch All Desktops
Upm:

hong@b local

Launch All Deskiops

Launch All Desktops by Tags of a User Principal Name (UPN)

Launches all the desktop resources by tags for the given UPN. The AP will return
without waiting for logon completion, of if an effor has occurred

Launch All Desktops By Tags
Upn:

hong@ e local

Tags:

test2
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Single-sessign 05 Machin: 2 Multi-session 05 Machines 1 Sessions B

[5* Log Off @ View Machines =ss More ] 1
Current U... + | Mame Dalivery Group Machine Catalog | Brokering Time .. | Session State | Application State | Session Supp...
BVT\hong LaunchAllTestSS BVT.LOCAL Deccazional Group 1 Occasional Catal . - Disconnactad Decktop Single

BVTihong dapsVDA BVTLOCAL Decasional Group 1 Occasional Catal - Disconnected Deskiop Single

BVTihong -launchAllTestSS.BVT.LOCAL

Session

Session Machine

EVTihong
Bddx

Deskiop

S State Disconnected
O minutes
12730724, 619 AM
1273024, 210 PM (Lecal. UTC08:001
Dasktop
0000
Unknown
V.0
dapsDDC BVTLOCAL
dapshost byt local
10047232 86
Windows 10

Launch All Desktops of AD Groups

Enter the AD Groups, scroll down and then click Launch All Desktops of AD Groups. A prompt will
confirm if the launch resources successfully triggered. Then, verify the sessions in Citrix Studio.
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C m 25 dapshostbvtlocal/sessionrem t

irix Leaming Cent... @ Citrix Workspace My Tickets -
dapshost.bvtlocal says
Upn:
Launch all desktops of AD groups completed. Transaction|D: S0faedis-
userl@domain.com a508-4d28-b267-21926741daas, Status: Success.
Please check sessions in studic.

Launch All Deskiops By Tags

Launch All Desktops of AD Groups

Launches all the desktop resources for the given AD groups. The AP will return without
waiting for logon completion, or if an error has occurred.
Launch All Desktops of AD Groups

ADGroups:

testLaunchADGroup

Tags:

tag1, tag2, tag3
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% Log Off & View Machines was More

Current ... 4 | Name

BV Tihong dapsTSVDABVTLOCAL
BVTihong lsunchAllTestSS BYTLOCAL
BVTihong dapsVDA BVTLOCAL
BVT\pengt dapsTSVDA BVTLOCAL

BVT\pengt -dapsTSVDABVT.LOCAL

Session

Session
BVT\pengt
Hedx
Dasktop

Disconnected
1 minute
12730724, 637 AM

Dasktop

0000

Unknawn

w0

dapsDDC EVTLOCAL
DAPSHOSTEVTLOCAL
1014723286
Windows 20122

Delivery Group
Daily Group

Decasional Group 1
Oceasional Group 1

Daly Group

12/30/24, 237 PM (Local. UTC+08:00)

Sessions o

Machine Catalog | Brokering Time...
Daily Catalog
Occasional Catal

Occasional Catal

Daily Catalog

Machine

(U]

| Session State Application State

Disconnacted Deskiog Ml
Disconnected Deskiap Single
Disconnected Desktop Single
Disconnected Deskiap Ml

dapsTSVDABVTLOCAL

I}

Session Supp...

Logoff Sessions of a User Principal Name (UPN)

Enter the User Principal Name (UPN) and select whether to log off disconnected sessions only or
Session Remote Start service-launched and disconnected sessions only. Then, click Logoff Ses-

sions. A prompt will confirm if the logoff sessions request is successfully triggered. Finally, verify the

sessions in Citrix Studio.

Logofr sessians

Logoft Disconnacted Sessions Oniy
Logeft SRS Service Prelaunched Disconneciad Sessians Only

Verify Session Remote Start API Calls

March 12,2025
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Enumeration and Launch

Asample scriptis provided in the Citrix download package to verify the installation, configuration, and

API calls. Script Name: enum_launch_example.psl

Recommendation:

+ Run the script on the third-party Authentication Service host for proper verification.

+ The script retrieves and launches resources by calling Session Remote Start APlIs.

Execution in PowerShell:

Run the script with two mandatory parameters:

1. Fqdn-The FQDN of the Session Remote Start server

2. UPNs—An array of UPNs and Resource Names, formatted as:

+ UPN:ResourceName (example: user@example.com:Desktopl)

« If the resource name is omitted, the first available resource will be launched.

Example:

.\enum_launch_example.psl -Fqdn "srs-server.domain.com"-Upns "SRSuserl@domain

.com:SRS-Server2019","SRSuser2@domain.com"

Explanation:

+ SRSuserl@domain.comisassigned to launch the desktop “SRS-Server2019”(the name as it

appears in their workspace).

+ SRSuser2@domatin.com has no specific resource assigned. In this case, the script will auto-

matically launch the first available resource from the user’s resource list.

This ensures that Session Remote Start correctly retrieves and launches desktops for the specified

users.
Output:
d Name HasMoreData Command
3 Job3 ; True
Jebll Running True
9 Job9 Completed True
Jeb Completed True
Joblde[§] ==mememesccccmese—————ee———————————————
8rl01l.local], ResourceName=[PMD-Server2019-2].
Fequesta. ..
fully.
- [BMD-Server2019-2] request for UPN=

=
for UP md-user28rl0ll, local], B

———————————— End
Start jecb for
Sending enume

[pmd-userl@rl0il.local], ResourceMame=[].

e the first rescurce=[PMD-Server2019] in the list.
4 [PMD-Server20193] request for UPN=[pmd-userld
1 Re su fully
Complete job for UPN=[pmd-userl@rlOll.local], ResourceName=[PMD-Server2019].

JobIde[11] =mmmmmmm o

8rl0ll.local]...

mmm B o
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Review the script execution output to ensure resources are pre-launched successfully.

Alternatively, verify in Citrix Studio. Before running the script, no active sessions must be visible for
the target machines.

Yujie Miao (..

CitriX | DaaS Premium o soakdstgcp2 COID:soakdstaee

Manage Monitor Downloads
Home Q_ sear P Filters  NameContains™emd” @ + ¥ = C @

soarch le-session 03 Machin Multisession 08 Machines (5)  Sessions (@)

=3
8

Hosting No results found.

> 0 AdBileR WO LOE

®

After running the script: The sessions should appear in a disconnected state, confirming that the re-

sources are pre-launched and ready for user reconnection.

Yujie Miao (2.

cifrix | Daas Premium o soak4stgcp2 COID:soakdstec?

Manage Monitor Downloads
@ veme Q Sea @ Filters | Neme Containspmd” @+ 1% c o
Q searen Single-session O Machine Multi-session 0 Machines (5 Sessions @)

Machine Catalogs
® ¢ 0 m
& o Current User + Delivery Group Machine Catalog Brokering Time (UTC) | Session State | Application State | Session Support
B Apo roT\pmd-use pmd-dg pmd-catalog Disconnacted Desktop Mult
10T \pmd-user2 pmd-dg2 pmd-catalog Disconnected Desktop Muli

Polices
@ s
[=Jere
& o
)
B 7on
G e i — Lestrefreshes: 55225 P con 1o bring dataup to date B
§ cusosoy Click an item to view the details

Logoff

This script logs off user sessions by calling Session Remote Start APIs. A sample script is provided in
the Citrix download package to verify. The Script Name: Llogoff_example.psl

© 1997-2025 Citrix Systems, Inc. All rights reserved. 44



Citrix Session Remote Start

Running the Logoff Script in PowerShell with two mandatory parameters:

1. Fqdn-The FQDN of the Session Remote Start server.

2. Upns —An array of UPNs (User Principal Names). By default, the script logs off all sessions, re-

gardless of their state.

3. AllDisconnected: It will only log off the disconnected sessions if set to true.

4. SRSLaunchedDisconnectedOnly: Set to true to log off only sessions launched by the Session

Remote Start Service that are currently disconnected.

Example:

.\logoff_example.psl -Fgdn "srs-server.domain.com"-Upns "SRSuserl@domain
.com","SRSuser2@domain.com"-SRSLaunchedDisconnectedOnly $true

In this example, the script will logoff all the resources launched by Session Remote Start service and
currently in disconnected state for the users SRSuserl@domain.comand SRSuser2@domain.

com.
Output:
Id Name PSJobTypeName State HasMoreData Location Command
9 Job9 BackgroundJob Running True localhost
11 Jobll BackgroundJob Running True localhost
9 Job% BackgroundJob Completed True localhost
11 Jobll BackgroundJob Completed True localhost

Jobs completed, getting outputs....

Start job for UPN=[pmd-user2@rl01l.local].
Sending logoff resources request...

Logoff resources successfully.

Complete job for UPN=[pmd-user2@rl011.local].

Start job for UPN=[pmd-userl@rl0ll.local].
Sending logoff resources regquest...

Logoff resources successfully.

Complete job for UPN=[pmd-userl@rl0ll.local].

——————————————————————————————————— JOBIA=[9] === mmm = mm s

——————————————————————————————————— ENd s=escccccccsc e s s s e s s s s s s e s m e —————

——————————————————————————————————— JOBIA=[11] === mmmmmm oo

Note:

This APl only sends the logoff request and does not wait for the sessions to fully log off.

NetScaler® for Load Balancing Multiple Session Remote Start Servers

November 26, 2025

Session Remote Start supports multiple servers to load balance the requests effectively. We recom-

mend using NetScaler as a Load Balancer.
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NetScaler Configuration
System Requirements for NetScaler as a Load Balancer

The following table lists the minimum requirements.

0sS NetScalerVPX 13.1

Processor 4 or more cores on a compatible 64-bit processor
RAM Min 8GB

Storage 50 GB

Enable load balancing

Navigate to System > Settings, and in Configure Basic Features, select Load Balancing.

CifriX. ADC VPX AZURE BYOL (8000)

Dashboard Configuration Reporting Documentation Downloads %

< Configure Basic Features

Configure server objects

Create an entry for your server on the NetScaler appliance. The NetScaler appliance supports IP ad-
dress based servers and domain-based servers. If you create an IP address based server, you can
specify the name of the server instead of its IP address when you create a service.

1. If you want to specify the name of the server instead of its IP address, add an address record
first. Otherwise, skip this step.

Navigate to Traffic Management > DNS > Records > Address Records, and add an address
record.
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Dashboard Configuration Reporting

< Create Address Record

Host Name*

©

srs-demo.rlO11.local

IPAddress®

© [+]

10.011.31 b

TTL {secs)
3600

2. Navigate to Traffic Management > Load Balancing > Servers, and add a server object.

© 1997-2025 Citrix Systems, Inc. All rights reserved.

47



Citrix Session Remote Start

Dashboard Configuration Reporting

< Create Server

Name*
srs-serverl (D
IP Address (@ Domain Name

FQDN*
srs-demo.rl011.local (D

Traffic Domain

Translation IF Address

Translation Mask

Resolve Retry (secs)

IE @

|:| IPvE Domain
Enable after Creating

Query Type

A R

Comments

Documen
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Repeat the two steps if you have multiple servers.

Configure services

1. Navigate to Traffic Management> Load Balancing > Services, and add a service.

Dashboard Configuration Reporting

<~ Load Balancing Service

Basic Settings

Service Mame®

srs-servicel (i)

Mew Server .@. Existing Server
Server®

grs-server] (srs-demo.rl011.local) W $
Protocol®

SSL v (D)
Port*

443
» More

«

2. In Thresholds & Timeouts, modify the value of Server Idle Time-out according to the average

launching processing seconds in your environment.

© 1997-2025 Citrix Systems, Inc. All rights reserved. 49



Citrix Session Remote Start

< Load Balancing Service

Basic Settings

Service Mame srs-servicel
Server Name srs-serveri
Server State ®DOWN
Protocol S5L

Port 443
Comments

Monitoring Connection Close Bit NONE

Thresholds & Timeouts

Service Name*

srs-servicel | (D

Threshold

Maximum Bandwidth (Kbps)

0

Monitor Threshold

0

Max Requests

0

Max Clients

0

Idle Time-out (sec)

Client Idle Time-out

1000

Server ldle Time-out

1000

@D
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Repeat the operation if you have multiple servers.

Create a virtual server

1. Navigate to Traffic Management > Load Balancing > Virtual Servers, and then create a virtual

server.
Cifrix. ADC VPX AZURE BYOL (8000)
Dashboard Configuration Reporting Documentation Downloads

< Load Balancing Virtual Server
Basic Settings

Create a virtual server by specifying a name, an IP address, a port, and a protocol type. If an application is accessible from the Internet, the virtual server IP (VIR
You can configure multiple virtual servers to receive client requests, thereby increasing the availability of resources to process client requests

Name*

srs-lb

Protocol*

w

s v

|P Address Type*

P Address v

IP Address*
.0 .11 .1

Port*

443

» More

2. Bind services to the virtual server.

° ~ Services

Sorvices @ AutoDetectedServices 0 Internal Services 8

Groups

rt yoQ
lanagement ~ o RT PROTOCOL
[m] 53 DNS
Load Balancing
[m] 0019 5563 HTTP
Virtual
Servers srs-sanvicel eup 100131 243 sst
Services srs-sarvice? oup 1001132 23 ssl
Seniice >} sis-sonvice3 oup 10007 o

3. InTraffic Settings, modify the value of Client Idle Time-out according to the average launching
processing seconds in your environment.

Traffic Settings /7 x

Ca NO
ENABLED
DISABLED
OFF

Trof ~ ENABLED

onse PASSIVE
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Configure a Responder Policy to drop untrusted IP addresses (Optional)

1. Enabletheresponderfeature. Navigate to System > Settings, and in Configure Advanced Fea-

tures, select Responder.

HA Status artiti
@ Not conflgured

CifrIX. ADC VPX AZURE BYOL (8000)

Dashboard Configuration Reporting Documentation Downloads

<~ Configure Advanced Features

[ - J&=»

2. Configure aresponder policy. Navigate to AppExpert > Responder > Policies, and add a policy.

HA Status artition -
Notconfigured  geroutt

cifrix. ADC VPX AZURE BYOL (8000)

Dashboard Gonfiguration Reporting Documentation Downloads

& Create Responder Policy

Name'

... Ja=»

In this example, the policy drops any request except for the ones from the specific IP addresses
-10.0.11.25/10.0.0.7.

3. Bind policy to the virtual server. Navigate to Traffic Management > Load Balancing > Virtual
Servers. On the Load Balancing Virtual Servers page, select the virtual server to which you
want to bind the responder policy, and then click Open.
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Choose Type > Policy Binding > Responder Policies
Responder Policies @) x

Q

;;;;;;;;;;;

@  Den s ICLENTIPSRC EQ(1001125) 88 CLIENTIPSRC EQUI0007)

StoreFront™ Configuration
Gateway Configuration

1. Add each Session Remote Start as a gateway following ‘Add Session Remote Start as a Gateway’
section.

2. Apply each gateway to the Session Remote Start store following the ‘Configure Remote Access
Settings’section.

StoreFront Plugin Configuration
Add each Session Remote Start URL to ‘srs_server_urls’following the ‘Configure Session Remote Start

plugin’section.

Supplementary features

November 26, 2025

1. Telemetry

Telemetry is used to collect and analyze the usage of Session Remote Start. It tracks key metrics, in-
cluding detailed request logs, usage trends (such as request frequency), success and failure counts
and Session launch success rate. This data helps monitor performance, identify issues, and optimize
system efficiency.
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How to use

Open https://<SessionRemoteStartFQDN>/SessionRemoteStart/telemetry/ina
web browser, and the overview page will be displayed.

Overview page

The Overview page displays data analysis based on seven key metrics: average session launch time,
average session connection time, pre-launched session count, reconnected session count, ses-
sion launch success rate, total saved time, and session utilization rate. Additionally, the Teleme-
try Ul includes a time range picker and a delivery group filter,allowing users to filter data by a
selected time period or a selected delivery group.

SRS Usage Tracking Dashboard

Gl overviem deivery_group_fler Time Period: | B 11172025 ~ | W 1zaz0s

499

99.45

The otal ime saved due fo session pre-aunching by SRS, which reduces the logon delay for users

42185.46

94.86

Trends page

Click Trends in the left navigation panel to open the Trends page. This page tracks SRS usage trends
based on three key metrics: session launch success rate, pre-launched session count, and session
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utilization rate. Users can also select different time periods or the delivery group to analyze usage

patterns.

SRS Requests page:

Click SRS Requests in the left navigation panel to open the SRS Requests page. This page displays
all SRS operation requests, allowing users to search, filter by execution result and request type,
and select a time period for viewing requests. Additionally, users can export operation requests
based on the applied search and filters.

SRS Usage Tracking Dashboard

s G= — Timo orioa: & wzuao
. " F— B P— .
s © suceess
(4 SRS Requests o © seeess
@ suceess
. © weee
vl SA1-1-CIETBA6D-0001 2 @ faicd
A1L1.CIETBA6D.0001 o @ taics
46D 0001 9% @ suseess
460 0001 0 @ faiea
© e
@ suce
© succ
© amee
o @ suseess
sz © s

025719, 4502 PM E s © ssess

Configurations

SRS Usage Insights collects the data through the three primary methods:
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« Actively gathering data while Session Remote Start processes requests and storing it in data
files.

+ Retrieving data from the Citrix Monitor Service API to supplement relevant information.

+ Automatically gathering data for the last N days (N is pre-defined in “AutoTelemetryCollecting-
Days”, the default value is 30) from local data files and Citrix Monitor Service API. It is executed
by a background task every 24 hours.

Local Data Collection and Storage

Telemetry server data collection is enabled if “TelemetryCredentialName”is configured. By default,
telemetry data is stored in %AppData%\Citrix\SessionRemoteStart\TelemetryData.

Grant Permission to collect Performance Monitor Data

1. Onthe Session Remote Start server, open Computer Management, select System Tools > Local
Users and Groups > Groups. Right-click Performance Monitor Users on the right panel, and
select Add to Group....

A Computer Management - O X
File Action View Help
e | nE XE = BE

& Computer Management (Local | Name

Description Actions

v [rj System Tools

& Device Manager
v = Storage

= Disk Management
= Services and Applications

EE: Event Log Readers
il Guests

W Windows Server Backug B Hyper-V Administrators

eliis_lUsRS
%.Network Configuration Operators
Performance Log

Performance Monitor Users

% Power Users

%.Storage Replica Administrators
ég: Systemn Managed Accounts Group

ég: Users

Members of this group can read e...
Guests have the same access as m..
Members of this group have com...
Built-in greup used by Internet Inf...
Members in this group can have s...
Members of this group may sche...

Add te Group...

Members of this gr-

Power Users are ind

%Eprint Operators Members can admir All Tasks
IRDS Endpoint Servers Servers in this groug

RDS Management Servers Servers in this groug Lelels

B RDS Rermnote Access Servers Servers in this groug Rename
i Remote Desktop Users Members in this gro Properties
i Remote Management Users Members of this grc

il Replicator Supports file replica Help

Members of this group have com..,
Members of this group are mana...
Users are prevented from making ...

o ég:Access Control Assistance Operators Members of this group can remot... Groups -
I\'@) :::S\cfl;:::’ler %EAdministrators Administrators have complete an... More Actions »

* Shared Fold e Backup Operators Backup Operators can override se...

arei olders 1

- i Local Users and Groups Bl Certificate Service DCOM Access Members of this group are allowe... Performance Monitor Users &
" = Users P %ECryptngraphi( Operators Members are authorized to perfor... Mare Actions »

% Device Owners Members of this group can chang...

T e Distributed COM Users Members are allowed to launch, a...

2. Click Add.. and then click Locations... and select your local computer. If a domain user is

specified as the application pool identity, select the domain instead. For more information, see

Configuration for Accessing Other API Services.
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General

Select this object type:

|Users. Service Accounts, or Groups | COhbject Types...

From this location:

|r|ﬂ11.|oca| || Locations...

Locations

Select the location you want to search.

Location:

= : E_rrtire Directory
(-3 10711 Jocal

3. Input the Session Remote Start application pool identity. For more information, see Configura-

tion for Accessing Other API Services. If the defaultidentity isused, please input IIS AppPool
\SrsAppPool instead.

Select Users or Groups

Select this object type:

|Users. Groups, or Built-n security principals | Object Types...

Fram this location:
| PMD-SERVER |

Locations...

Enter the object names to select (examples):
FMD-SERVER ars

Check Mames

Advanced... Cancel

4. Open PowerShell, and run the following commandlet:

iisreset

Retrieving data from the Citrix Monitor Service API

Configure the Citrix Monitor Service API URL and Credential.
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1. Test Connectivity and configure the credential. For more information, see Configure the Applica-
tion Pool Identity for Session Remote Start and Configuration for Accessing Other API Services.

2. Editweb.configtoset TelemetryCredentialName to the credential created in step 1.
For more information, see Configuration file.

Note:

For security considerations, itis mandatory to enable TLS for Monitor OData APl access. For more
information, see Securing On-Premises Monitor OData API Access.

2. Auto Logoff of Idle Sessions Launched by SRS

To conserve resources, Session Remote Start (SRS) can be configured for automatic logoff of pre-
launched sessions. If a session is not reconnected within the specified time, the logoff timer can be
adjusted to automatically terminate it.

This feature requires:

1. Configure the Application Pool Identity for Session Remote Start and REST APl access.

2. Configureweb.conf1gto enable this feature, and customize the time period. For more infor-

mation, see Configuration file.

3. Session Remote Start plugins for StoreFront™
Overview

During the Session Remote Start pre-launch process, if an end-user attempts to launch the same re-
source via Citrix Workspace™ App (CWA) or their normal login method, StoreFront may display an error
message, which can be unexpected or confusing.

To prevent this, a plugin should be applied to the store that users access via CWA (not the Session
Remote Start store). When applied, the plugin will:

1. Add a Preparing indicator to the resource name.

el
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2. Hold the launch request if the user clicks the resource and resumes it once pre-launch is com-
plete.

e

v22 - Preparing

Additionally, the plugins support simultaneous execution with existing plugins without conflicts,
meaning that this plugin can work alongside other StoreFront plugins without causing issues or
interfering with their functionality.

Steps to add the StoreFront Plugins

Backup Existing Plugins

1. Navigate to the StoreFront Server: Go to the following directory: C:\inetpub\wwwroot\
Citrix\\%StoreName%\b1in\. Ensure this is the store that users access via CWA, not the
Session Remote Start store.

2. Backup the existing plugin files: Copy the following files:

« StoreCustomization_Input.dll

+ StoreCustomization_Enumeration.dll and pastethem into a backup directory,
for example: C:\stf_original_plugin\. This ensures that you have a backup of
the original plugins before making any modifications.

3. Copy and paste the following three DLLs provided by the Citrix team (StoreFrontPlugin folder):

« StoreCustomization_Input.dll
« StoreCustomization_Enumeration.dll
« SrsStoreFrontPluginCommon.dll

4. Set up system environment variables:
a) Open System Settings > open Control Panel > click System > Click Advanced system

settings > Click Environment Variables >Under the System Variables section, click New

b) In the New System Variable window, enter the required environment variables as
shown in the table below.
c) Click OK. Close all remaining windows by clicking OK.

This ensures that the StoreFront plugin functions correctly with the Session Remote Start integra-
tion.
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Variable Name Required/Optional

srs_server_urls Required

stf_original_plugins_pathOptional

launching_suffix Optional

Description

Session Remote Start
server URL

Original plugins
directory

Resource title suffix
while preparing by

Session Remote Start.

If not configured,
- Preparingby
default.

Example

https:

C:\
stf_original_plugin

- Preparing

1. Grantaccessto stf_original_plugins_path. Similar to Session Remote Start file per-

mission configuration, grant access to StoreFront application pool identity.

2. RestartlIS service-iisreset.

FAQ

November 26, 2025

Response 404 - UPNNotFound

It may not really be caused by UPNNotFound, but most caused by StoreFront™ authentication for

various reasons:

1. Communication error between Session Remote Start and StoreFront:

a) OpenWeb.conf1g,double confirmthe StoreFrontServer option. Arecommended prac-
tice is to set StoreFrontServer by copy from Receiver from Web Sites in StoreFront Ul.

Please note that the StoreFront store name is case-sensitive.

b) Tryto open StoreFrontServer by browser, check ifthereis a connection or certificate error.

(Do not need to login, just check if the web page can be visited normally.)
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c) Open CDF trace tool or enable Session Remote Start log file, check if there is any error
detail.

2. StoreFrontissue:
Open Event Viewer > Applications and Services Logs > Citrix Delivery Services to check
StoreFront log

3. FASissue:
For step 2, the error may be related to FAS, please refer to the FAS section of the checklist above.

Request Timeout

+ Session Remote Start has a RequestTimeoutSeconds option in Web.config. When request
duration reaches the timeout, Session Remote Start will respond with status code 408 and body
content.

+ Session Remote Start will never terminate http connection without response. Please check if
there is any timeout related setting in the caller.

« Forthe LaunchResource API, thereisan optional parameterWaitForLogonNotification

recognized as true by default. For the VDAs really take a long time for launching,
WaitForLogonNotification can be set to false. API will respond immediately and
execute the launching process in the backend.

Remain in ‘Connected’State

If a session remains in the Connected state, there may be an authentication issue.

+ Please review the FAS configuration and check the Session Remote Start logs.

+ In the DaaS environment, please check if the Cloud Connector is working properly. Pay special
attention to whether the firewall is configured correctly and does not block traffic from Store-
Front.

Remain in ‘Active’State

If a session remains in the Active state, the logon script configured in the Group Policy on AD may have
failed to trigger the disconnect operation. Verify the Group Policy configuration, especially whether it
has been successfully applied to the VDA.

Double Hop Sessions

SRS functions as expected in a double hop scenario without requiring any additional configuration.
However, if domain pass-through is enabled in the double hop setup, features like HTTP Basic Authen-
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tication should be avoided on the second hop, as they can cause unexpected behavior.

Known issues

November 26, 2025

1. SRS does not support Linux or MAC VDA.

2. The Launch All Desktops by Tags feature has a limitation when configured with any of the fol-
lowing two settings:

a) When a tagis applied to a Static Delivery Group.
b) If the desktops within a delivery group are assigned to an Active Directory (AD) group in-
stead of individual users.

The feature will not be able to retrieve and launch those desktops.

3. If a session is resumed from a hibernated state by Session Remote Start (SRS), the auto logoff
feature cannot currently identify it as a pre-launched session. As a result, the session will not
be logged off automatically if configured to logoff.

4. SRS cannot log off resumed sessions if they are not reconnected, regardless of how they were
resumed.

5. If the SRS app uses the default application pool SrsAppPool, the configuration of this pool will
be reset.

6. When load balancing StoreFront with NetScaler ADC, the persistence type only supports
SOURCEIP. COOKIEINSERT isnotsupported.

7. Due to a limitation in StoreFront versions prior to 2507 (i.e., 2503 and earlier), in a hybrid sce-
nario, if StoreFront has Site Aggregation enabled, when launching a session, the SRS would
incorrectly trigger an unnecessary launch operation because it fails to query/find the already-
launched session when checking for its existence.

8. When upgrading StoreFront, if the SRS plugin has been previously applied, it is required to first
restore the plugin, complete the StoreFront upgrade, and subsequently re-apply the plugin.

Upgrade Instructions

November 26, 2025
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When updating SRS to the latest version, follow these instructions on both the SRS and StoreFront
servers.

SRS server

1. BackupWeb.conf1ig.

2. Backup Application Pool.

3. Execute %windir%\system32\inetsrv\appcmd list apppool /config /xml
> AppPoolsBackup.xml or other commands that can record the app pool configuration.

4. Run SessionRemoteStartSetup.exe to perform an in-place upgrade.

5. Recover Application Pool.

6. Double-check the Web. conf1gfile to ensure the configuration is properly merged.

StoreFront

1. Replace the StoreFront Plugin: StoreCustomization_Enumeration.dlLl.

1.0.7t01.0.8

SRS Server

1. BackupWeb.config.
2. Backup Application Pool.
Execute %windir%\system32\inetsrv\appcmd list apppool /config /xml
> AppPoolsBackup.xml or other commands that can record the app pool configuration.
3. Run SessionRemoteStartSetup.exe to perform an in-place upgrade.
4. Double-check the Web.conf1g file to ensure the configuration is properly merged.
5. Double-check the Application Pool to ensure the configuration is not changed.

1.0.8t01.0.9

SRS Server

1. BackupWeb.conf-ig.
2. Backup Application Pool.
Execute %windir%\system32\inetsrv\appcmd list apppool /config /xml
> AppPoolsBackup.xml or other commands that can record the app pool configuration.
3. Run SessionRemoteStartSetup.exe to perform anin-place upgrade.
4. Double-check the Web.conf1g file to ensure the configuration is properly merged.
5. Double-check the Application Pool to ensure the configuration is not changed.
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Optional Configurations

November 26, 2025

1. Configure the Application Pool Identity for SRS
Overview

By default, Session Remote Start (SRS) runs under the SrsAppPool application pool, with its identity
set to ApplicationPoolIdentity. However, if specific features require elevated permissions,
the identity must be configured as a domain user or local user to ensure proper functionality.

Prepare the Identity

Domain User:

A domain user is required for the Launch All Desktops by AD Group feature. For security
purposes, it is recommended to create a dedicated domain user with minimal access
rights.

On the Domain Controller, create a user or use an existing Domain Service Account.

Open the Active Directory Users and Computer.

1. Inthe left pane, right-click your domain and select Delegate Control from the context menu to
open the Delegation of Control Wizard.

2. Add/Select the domain user created above and grant the Read all user information permis-

sion.

File Action View Help

e am FORE G Bm PeETE%
] Active Directory Users and Cf " ~
Saved Queries Delegation of Contrel Wizard X
~ [l Tasks to Delegate 'd;,) 1
Builtini You can select common tasks of customize your own %

Computers
51 Demain Controllers .
ForeignSecurityPrinci| (®) Delegate the folowing commen tasks:
Managed Service Acc| [] Reset user passwords snd force password change o nedt lagen '
Users B Read al user information
[] Modéy the membership of a group
[ Join a computer to the domain
[[] Manage Group Policy lrks
[] Generate Resultart Set of Policy (Planning)
[] Generate Resultant Set of Policy (Logging) N
< >

() Create a custom task to delegate

clack [ Net> | | Cancel Help

= groupT SECUTTy TR
< * || B8 aroun? Security Group... .
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Local user:

A local user account on SRS server is required for the following features to work.

Launch All Desktops by Tags

Log off VDAs by a specified UPN (if they were pre-launched by SRS and not reconnected).
Support pre-launch from a hibernated VM.

Automatically log off VDAs pre-launched by SRS if they remain unconnected within the specified

W

time.
5. Telemetry data collection and analysis.

To enable the above features, a local user must be created on SRS server and configured with the
necessary permissions.

Two options are available to create the local user:

« Reuse an existing standard local user.
+ Create anew onebyrunning create-local-user.pslon the SRS server from the installa-
tion package downloaded from Citrix Downloads, as an administrator.

The script will create a standard local user with general access.

EN Administrator: Windows PowerShell

for hos on Remote Start (default: srs):
Enter password for user srs FEEXELEEEEH

User srs has been created

Mame Enabled Description

If none of the features listed above are required, you can skip the following steps in this section.

Configure Application Pool Identity

1. On the SRS server, open IIS Manager, from the Application Pools, highlight SrsAppPool and
on the right side, select Advanced Settings under the Edit Application Pool. Scroll down to
Process Model > Identity click on the three dots.
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:g' St - This page lets you view and h i the ions, and provide isolation among different applications. Set Applicstion EealESA
45 jockw-daps-demo ackw-dag Advanced Settings T x ‘rppiication Pool Tasks
3 Appiication Pools Filter: ~ ¥ Go - G Show Al | Group by: No Gro .
{81 Sites Name Status  NETCLRV.. Managed Pipel.. Identt] |v (Genera) ~
2 NETv20 Staed 2.0 Integreted Applic n
D NETV20 Classic ~ Stated 2.0 Classic Applic
D NETVAS Stated w40 Integrated Applic)
LD NETVAS Classic  Stated 4.0 Classic Applic
(D Classic NETAp... Started 2.0 Classic Applic|
2} DapsAppPool Stated w40 Integrated daps
D DefaultAppPool  Stated w40 Integrated sis
Stated w40 Integrated Applic| o
Noct
H
Fa
4204067205

Mask (64-bit ¢ 4204967205

Aoplcstionpootigentey [T
\dle Time-out (minutes) 20
die e out Action Terminate v
dentity
lidentityType, username, password] Configures the application pool to run
35 built-in account, i.e. Application Pool Identity (recommended), Network
o

rvice, Local Systemn, Local Se

oK Cancel

2. Select Custom account, click Set, and input the username and password of the user created
above (domain or local user) to host Session Remote Start.

(O Built-in account:

Set Credentials ? X
J:ancel
User name: [
- |I
I
Password:
[ .| pool to run
a [ ), Network
E I
Confirm password:
‘ Cancel

I Cancel -

3. Ensure the Application Pool’s setProfileEnvironment attribute is enabled.

a) Navigatetothe %windir%/system32/inetsrv/configfolder.

b) Openthe applicationHost.configfile.

c) Locate the <system.applicationHost><applicationPools><SrsAppPool
><processModel> element.

d) ConfirmthatthesetProfileEnvironmentattributeisnotpresent, which defaultsthe
value to true, or explicitly set the attribute’s value to true.

© 1997-2025 Citrix Systems, Inc. All rights reserved. 66



Citrix Session Remote Start

2. Configuration for Accessing Other API Services
Overview

The following Session Remote Start (SRS) features require CVAD 2308 or later and Citrix DaaS™ REST
APIs to be enabled and supported:

+ Launch All Desktops by Tags.
+ Log off VDAs by a specified UPN (if pre-launched by SRS and not reconnected).
« Support pre-launch from a hibernated VM.

Automatically log off VDAs pre-launched by SRS if they remain unconnected within the specified
time.

Additionally, Citrix Monitor Service API requires CVAD 2305 or later for the following feature:
» Telemetry

If none of the features listed above are required, you can skip the following steps in this section.

Connectivity test

Firstly, verify whether Session Remote Start (SRS) can communicate with the API services. These ser-
vices are typically hosted on the Delivery Controller™ (DDC).

Execute the below test scripts in the installation package:

For CVAD REST APIs (On-Prem), execute the CvadApiConnectivityCheck-OnPrem.psl.
« For Citrix DaaS REST APIs, execute the CvadApiConnectivityCheck-Cloud.ps1.

« For CitrixMonitor Service API (On-Prem), executetheMonitorServiceApiConnectivityCheck
-OnPrem.psl. TLS for Monitor OData APl access should be enabled. See Securing
On-Premises Monitor OData API Access.

« For Citrix Monitor Service APl (DaaS), executetheMonitorServiceApiConnectivityCheck
-Cloud.psl.

Configure the credentials

Session Remote Start (SRS) requires credentials to authenticate and issue API requests to external
API services. These credentials are securely stored under a user account in the Windows Credential
Manager to ensure secure access and authorization.
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In the installation package, navigate to the SessionRemoteStart folder. Locate the PowerShell script
store-cred.psl and execute it as an administrator to configure the required credentials for Ses-
sion Remote Start (SRS). This will securely store the credentials in Windows Credential Manager for

APl authentication.

An admin account in Session

Remote Start % =

For On-Prem environment, provide the admin credential. For more information, see here.
For the DaaS environment, provide the client identity. For more information, see here.

Note:

Different credential configurations can share the same actual credential. If multiple configura-
tions refer to the same credential, only one entry needs to be created in Windows Credential
Manager, and all configurations can reference it. This eliminates the need for duplicate creden-
tial entries.

A success message will be displayed after creation is complete.

EX Administrater: Windows PowerShell

3. Log configuration

Log Level Configuration
Currently, Session Remote Start logging supports CDF and File tracing. CDF logging is always enabled
by default. File tracing availability depends on the configuration file settings.

Trace severity level

+ 0-Critical
« 1-Urgent
+ 2-Significant
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« 3-Important

« 4 - ImportantDetailed

« 5-Informational

+ 6-InformationalDetailed
« 7-Notable

+ 8- NotableDetailed

+ 9-lInsignificant

Log to File

Logging to file is enabled by default. To disable, set LogFileName in Web.config to empty.

The default log path is shown below, where {Session Remote Start user} should be replaced with the
user hosting the SRS service. If the identity has been changed to another identity, replace Session
Remote Start user with the corresponding user directory.

"C:\Users\\{ Session Remote Start user } \AppData\Roaming\Citrix\
SessionRemoteStart\Logs\SessionRemoteStart.log".

Customers can change the log file location and permissions as per their requirements, please see the
steps required to change the Log file location and permissions.

4. Log Rotation Configuration

New Log Rotation Settingsinweb.config

Two new configuration parameters have been added to the web.config file to support log rotation:
MaxLogFileSizeMB and MaxBackupLogFiles.

+ MaxLogFileSizeMB: Sets the maximum size (in megabytes) for a log file. When this limit is
reached (default: 100 MB), the application automatically compresses and moves the log file
to the Arch-ive subfolder within the log directory. A new, empty log file is then created to
continue logging.

« MaxBackupLogFiles: Specifies the maximum number of archived log files to retain. When the
number of backups exceeds this limit (default: 10), the oldest archived files are automatically
deleted to make space for new ones.

5. Log to Event Viewer

Session Remote Start supports logging key operations to the Windows Event Log.
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« LogPath: Windows Logs > Application
(File location: %SystemRoot%\System32\Winevt\Logs\Application.evtx)
+ Event Source Name: "SessionRemoteStart"

This allows administrators to monitor and troubleshoot Session Remote Start events through the Win-
dows Event Viewer.

To enable this feature, set LogToEventViewer to true in web.config. (See Configuration
file).

Event types:

Event ID Description

1 Requests for enum, launch, and logoff
operations.

2 Responses to enum, launch, and logoff requests.

3 Authentication requests from StoreFront™ to
SRS.

4 Session launches via ICA® file.

5 Requests sent to StoreFront.

6 Requests sent to REST API.
Changes to Web.config.

8 Queries for groups/users under an AD group.

9 Reads from Windows Credential Manager.

6. Change Log File/Telemetry File Location

If the Log File location is changed, make sure that the Session Remote Start service has the necessary
permissions to modify the log file.

Log file permissions

1. Setan anonymous user identity to Application Pool Identity.

a) Open IIS Manager > Sites > Default Web Site > SessionRemoteStart and then open Au-
thentication under SessionRemoteStart Home page.
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Connextions

@- "8 ‘0 /SessionRemotesStart Home
" g | .
Start Page . - N
PMO-SERVER, (01 1\soaktest- us011) ‘I.k,“ . S Show 0| Geowp by Aren
2 Application Pools ASPHET ) ) )
%l Sites iz 4 L | U o 4
Al Default Web Sete ] 5 At ‘i\.-’ 2
B prni JNET JNET JNET Error NET NET Profile .NET Roles JNET Trust JNET Users  Appli|
I T Casonimcieiiat I Auth t. C P)gts Globalization Levels et

& &

Session State SMTP E-mail

s
s - - x
i ! = 1 | & g
0 2] 9 ¥ #H ¢ - & J
Authenticati | Compression  Default Directory  EmorPages  Handler HTTP Logging  MIME
on Docurnent  Browsing Mappings Respon..

Management

Configurat...
Edatar

b) Right-click Anonymous Authentication and click Enable.

c) Again, right click on select Anonymous Authentication > choose Edit > select the identity
consistent with Configuration for Accessing Other API Services.

Q- i\ |8 éﬁ Authentication

------ & Start Page

Group by: Mo Groupin <
v .93 PMD-SERVER (rI01soaktest-usD11) s ping

£} Application Pools Mame Status Respense Type
~ .[@| Sites I Anonymous Authentication Enabled I
v Q'E) Default Web Site ASP.MET Impersonation Disabled
.,:'D pm3 Forms Authentication Disabled HTTP 302 Login/Redirect

. -[2¥ SessionRemoteStart

Edit Anonymeus Authentication Credentials ? X

Anonymous user identity:
(O Specific user:
IUSR

I@ Application pool identity I

2. Now you can create a folder at your preferred location, and grant permissions to log to the new
folder.

a) Forexample, afterthefoldercreationunderC:\SessionRemoteStartlLog, right-click
the folder and select Properties. In the Security tab, click Edit under Group or user
names and then select Add to change the location to a local computer.
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FEILOgs 575 2z U A T Toer
Program Files SessionRemoteStartLog Properties
Program Files (x26)
b General Sharng Securty Previous Versions Customize
rogramData Securty
SessionRemoteStartLog | Objectname:  C\SessionRemoteStaniog
4 Object name:  C:\SessionRemoteStartLog
em
i Group or user names: 3
Users B8 Autherticated Users MOUp OF USEr names
Windows 82 5YSTEM B& Authenticated Users
‘WindowsAzure B Administrators (pmd-server\Administrators) i‘l SYSTEM X
£ daps_moniter.htm B2 Users (pmd-server'\Users) ;EAdmwmslramrs {pmd-server\Administrators)
- . SR Users {pmd-server'\Users)
& Web.config "
To change pemmissions, click Edit
Pemissions for Authenticated
lsers Allow Deny Remave
Ful control . Pemissions for Authenticated
Modify Users Hlow Deny
Read & execute et e o
List folder contents e
Read Select this object type
Wiite hd ‘Users‘ Groups, or Built4n security principals ‘ Object Types...
For special permissions or advanced settings,
click’jﬁdvaniad. “ Advanced From this location
[f011ocal M =

Enter the object names to select {examples):

Locations X
Select the location you want to search

Location:

=] PMD-SERVER]
Enfire Oirectory

=

31011 Jocal

Cancel

b) Inputthe Session Remote Start user created in the previous section. (If the default identity
isused, input ITIS AppPool\SrsAppPool instead).

Select Users or Groups >

Select this object type:

|Users, Groups, or Builtin security principals | Object Types...

Fram this location:
| PMD-SERVER |

Locations...

Enter the object names to select (2xamples):
PMD-SERVER"ars Check Mames

Advanced... Cancel

c) Grant Modify and Write permissions. (If the default identity is used, grant access to Sr-
sAppPool)
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Permissions for SessionRemoteStartLog x
Security
Object name:  C:\SessionRemoteStart Log

Group or user names:
SR Autherticated Users

- %=z User (PMD-SERVER ars)
2 Users (pmd-serveriUsers)

Add... FRemove
Permissions for srs User Allow Dery
| Modify =l 0o~
Fead & execute U
List folder contents ]
Read O
[Wiie O .

Cancel Aoply

7. Configure Inbound Firewall Rules

Specifying IP addresses and host names of the trusted services and StoreFront ensures that only these
sources can communicate with Session Remote Start and helps to prevent DoS or other opportunistic
attacks against the Session Remote Start server.

After creating the https binding on port 443, customers can configure inbound firewall rules by Win-
dows Defender Firewall with Advanced Security Ul to allow inbound TCP traffic.

1. Disable all 443 inbound rules except World Wide Web Service (HTTPS Traffic-In).
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Windows Defender Firewall with Advanced Security

e ion . view  Help

Windows Defender Inbound Rules
Name Group Profile  Enabled  Action  Override  Program  Local Address  Remote Address  Protocol  Local Pe A
B, Connection Security Rules | & Remote Desktap - User Made (TCP-In)  Remate Desktop Al Ves Allow  No %System.. Any Any TP 3389
., Monitoring 9 Remote Desktop - User Mode (UDP-In)  Remote Desktop Al Ves Allow  No System.. Any Any uop 3389
Remote Desktop - (TCP-WSS-In] Remote Desktop (WebSocket] Al No Allow  No System  Any Any TP
BranchCache Peer Discovery (WSD-In)  BranchCache - Peer Discove... Al No Allow  No Sisystem...  Any Local subnet uop
Network Discovery (Pub-WSD-In) Metwork Discovery Domai.. No Allow  No %System.. Any Local subnet uop
1 Network Discovery (Pub-WSD-In) Metwork Discovery Private  Ves Allow  No Local subnet uop
Network Discovery (WSD-In) Metwork Discovery Domai.. No Allow  No Local subnet uop
1 Network Discovery (WSD-In) Metwork Discovery Private  Ves Allow  No Local subnet uop
File and Printer Sharing (SMB-QUIC-In)  File and Printer Shering over... Al No Allow  No
Secure Socket Tunneling Protocol (S5TP-L. Secure Socket Tunneling Pr... Al No Allow  No
£ World Wide Web Services (HTTPS Traffic-... Secure World Wide Web Ser... Al Yes Allow  No
7 World Wide Web Services (QUIC Traffic-In) Secure World Wide Web Ser... [
File and Printer Sharing (SMB-In) File and Printer Sharing ]
Netlogon Service (NP-Ir) Netlogon Service o=
Remote Event Log Menagement (NP-In)  Remote Event Log Manage... Copy No Any TP 25
Remote Service Management (NP-In) ~ Remote Service Mansgement . No Any TP 25
£ Microsoft Media Foundation Network So... Micrasoft Medis Foundatio... Delete Ne Local subnet uoe 5000-50
£ mDNS (UDP-In) mDNS Properties No Any uoe 5353
£ mDNS (UDP-In) mDNS No Local subnet uoe 5353
€ mDNS (UDP-In) mDNS [ No Local subnet upp 5353
€ Microsoft Edge (mDNS-In) Microsoft Edge Al Yes Allow  No CaProgr..  Any Any uoe 5353

Note:

Remember to check if there are any enabled rules allowing all (all the limitations set to
any) inbound traffic.

2. Double-click World Wide Web Service (HTTPS Traffic-In), and open the Properties configura-
tion. Switch to the Scope tab.

3. Add local IP address limitation. This is the local endpoint(s) (Network Interface) for 3rd-party
Auth Service and StoreFront.
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General Programs and Services Femote Computers

Protocols and Ports Advanced  Local Principals ~ Remote Users

Local IP address
B O Any IP address

)
I@ These |P addresses:l

P Address

Specify the |P addresses to match:

(8 This IP address or subnet:

[10.0.07

Examples. 192.160.0.12
152.168.1.0-24
2002:9d3b:1a31:4:208: 74ff fe 39:6c43
2002:9d3b:1a31:4:208. 74 fe 39:0112

() This IP address range:
From:

To:

QK Cancel
| oK | rooly

4. Add remote IP address limitation. Add IP addresses of 3rd-party Auth Service and StoreFront.
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General Programs and Services
Pratecols and Ports Scope  Advanced
Local IP address
L (O Any IP address
L4
{®) These IP addresses:

10.00.7

Remate IP address
A O Any IP address
L
|® These IP addresses: |

Remote Computers

Local Principals ~ Remote Users

Add...

oK

Cancel

IP Address

Specify the IP addresses to match:

(@) This IP a

ddress or subnet:

[10005

Examples: 192.168.0.12

192.168.1.0/24
2002:3d3b:1231:4:208: 74 fe 33:6c43
2002:3d3b:1a31:4:208: 74f fe353:0/112

() This IP address range:

From:

To:

() Predefined set of computers:

Default

Apply

gateway

5. Switch to the Advanced tab and apply to related profile(s).

Cancel
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World Wide Web Services (HTTPS Traffic-In) Properties >

General Programs and Services Remote Computers
Protocols and Ports Scope | Advanced | Local Principals ~ Remote Users

Profiles

u Specify profiles to which this rule applies.
=l Domain
[ ] Private
[ ] Public

Interface types

Specify the interface types to which this Frroas
rule applies.

[

Edge traversal

+ Edge traversal allows the computer to accept unsolicited
™=  inbound packets that have passed through an edge device
such as a Metwork Address Translation (MAT) router ar
firewall.

Block edge traversal W

Prevent applications from receiving unsolicited traffic from
the Intemet through a NAT edae device.

Cancel Apply

Third party firewall products will require configuring separately.

8. App Protection

If App Protection is enabled for a delivery group, the customization described in this Citrix documen-
tation must be applied to the Session Remote Start store:

9. HTTP Proxy Configuration

Session Remote Start supports only unauthenticated HTTP proxies.

1. Configure the WinINet HTTP proxy. e.g.
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Settings

i Home

| Find a setting

MNetwork & Internet

£ Status

ww Wi-Fi

£ Ethernet
Dial-up

°® VPN

g~ Airplane mode
&) Mobile hotspot

e Proxy

Proxy

Automatic proxy setup

Use a proxy server for Ethernet or Wi-Fi connections. These settings
don't apply to VPN connections.

Automatically detect settings
@ on
Use setup script

@ of

Script address

L
@
@

Manual proxy setup

Use a proxy server for Ethernet or Wi-Fi connections. These settings
don't apply to VPN connections.

Use a proxy server

@ on
Address Port
| jackw-ad.xiaow.local | | 80 |

Use the proxy server except for addresses that start with the following
entries. Use semicolons () to separate entries.

*xiaow.local

Don't use the proxy server for local (intranet) addresses

Save

2. Append the following code toweb.conf1ig.

<system.net>

<defaultProxy useDefaultCredentials="true">
<proxy usesystemdefault="true" />

</defaultProxy>

</system.net>
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Web.config X

xmlns="urn

1 debug="true" targetFramework="4.7.2

= targetFramework="4.7_2"

name="
requirefcc

name=""FR tCapacityControlMiddleware™

useDefaultCredentials="true"
usesystemdefault="true"

10. mTLS configuration

Session Remote Start APl does not require end-user authentication, unlike StoreFront. Therefore, it
is essential to restrict access to trusted services only.

Enforcing Security with Mutual TLS (mTLS)

One way to ensure secure communication is by enforcing mutual TLS (mTLS) authentication between
Session Remote Start and other trusted services.

Steps to Enable mTLS

1. EdittheWeb.conf1igfile.
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2. LocatethemTLSEnabled setting and setit to true.

3. Specifythe certificate thumbprint to authenticate trusted services.

ey IS LAFLLITU valus
key="mTLSEnabled” value="false

key="mTLSClientCertificateThumbprints"” value="A1B2C3DUESF67898123U56T89ABCDEFB123U5678

This configuration ensures that only authorized services with a valid certificate can access Session

Remote Start, enhancing security.

11. Filtering Enumerated Resource Results Using Smart Access

We support Access Gateway broker access rules to filter enumerated resources based on Smart Access

policies.

For example, consider the below existing access policy.

Edit Policy

MetScaler-zonel

Policy name:

NetScaler-zonel

Specify the behavior of the include filter:
Filtered (dafault)
@) Via Access Gateway

Mat Via Access Gateway

B Include connections that meet the criteria

Match all @ Matchany
Filter: Value:
_XD_192168.1.19_443 PL.WB_10,107197.243
Filter: Value:
_XD_1921681.19_443 PL_WE_10.107197.244

= Add criteria

Exclude connections that don't meet the criteria

Mo criteria added

Add inclusion and exclusion criteria to filter user connections based on the Smart Access filter and value.

Policy state:
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Edit Web.conf1ig for Smart Access Filtering To enable Smart Access filtering for enumerated re-
source results, modify the Web.config file by adding or updating the following settings:

key »Enat 1" value

ke Y

key

SmartAccessFarmName - Specifies the Smart Access farm name (example: _XD_192.168.1.19
_443).

SmartAccessConditions - Defines the conditions for filtering enumerated resources based on
Smart Access rules.

12. Multi-Monitor Resolution Management

When customers use multiple monitors with different resolutions or scaling settings, they may expe-
rience display inconsistencies. The Launch User Resource APl allows them to configure screen resolu-
tion settings for a seamless experience.

During session preparation, SRS simulates the user’s screen layout based on the provided resolution
settings, ensuring consistency across all monitors.

To ensure accurate simulation, customers must manually collect monitor layout and resolution de-
tails. Citrix provides the collect_screen_resolution_example.ps1l script to simplify this
process.

Step 1: Collect Screen Layout

Run the following command on the Virtual Desktop Agent (VDA) to retrieve the screen layout:
.\collect_screen_resolution_example.psl -type ScreenlLayout

This will output the current screen layout configuration.

LeftPosition="960" TopPosition="0" Width="960" Height="1080"

</5Creens>

Step 2: Collect Monitor Resolution and Scaling Information

If the client devices have different screen resolutions, run the script on the Citrix Workspace™ App
(CWA) endpoint instead:

.\collect_screen_resolution_example.psl -type MonitorInfo
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This will collect the details such as Device PPl and Scale Factor for the client device.

Then format this to former Screen XML attribute as:

<Screens>
<Screen
LeftPosition="0" TopPosition="0" Width="960" Height="1080"
ScaleFactor=" 100 ” DevicePpi=" 166"~

/>
<Screen
LeftPosition="960" TopPosition="0" Width="960" Height="1080"
ScaleFactor=" 100 ” DevicePpi=" 166"~
/>
</Screens>

And make this as the parameter for the Launch User Resource API.

13. Secure HDX Support

SRS supports secure HDX support without requiring additional configuration.
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